
The Gift of Love and Song

Mantras



 

 

For Detailed information go to the Help Menu in Adobe Acrobat. 
  
Opening PDF documents 
The documents on this site open with page one and Bookmarks opened on the left pane for easy 
navigating to whatever page you would like to view. 
  
We do not default to Full Screen View, however if a document is set to open in Full Screen view, 
the tool bar, menu bar, and window controls are not visible. You can exit Full Screen view by 
pressing Escape, if your preferences are set this way, or by pressing Ctrl+L (Microsoft® 
Windows® and UNIX®) or Command+L (Mac OS).  
  

Viewing PDF documents on the Web 
With most of the files at this site, you can view PDF documents using a Web browser. Every 
document on the Web is identified by a (URL). When a PDF document is stored on the Web, you 
can click a URL link to it to open the PDF document in your 
Web browser.  This is the preferred method. 
  

Reading PDF documents in a Web browser 
  
In Win and Mac OS, PDF documents are displayed in the Web browsers compatible with 
Netscape Navigator 4.0 (or later) or Microsoft Internet Explorer 4.0 (or later).  
  
Normally the necessary plug-ins are automatically installed when you install Acrobat Reader. For 
information on manually getting your browser ready, see Installing the Web browser plug-in.  
  
(NOTE:  If pages of your PDF document appear blank when viewed in a Web browser, you may 
be using an early version of a Web server. Try saving the PDF file locally, and viewing it using 
Acrobat Reader instead of the plugin.) 
  
When you view a PDF document in a Web browser, all of the Acrobat Reader tools are available 
in the browser. In Windows, you can click the two small vertical lines (next to the Adobe icon at 
the left of the tool bar) to minimize or maximize the tool bar. 
  
Note: Many keyboard commands are mapped to the Web browser rather than to Acrobat Reader, 
so some Acrobat Reader keyboard shortcuts may not be available in the browser window. 
  
In UNIX, PDF documents can display in Web browsers compatible with Netscape 
Navigator 4.0 (or later) only. To set up Netscape compatibility, launch Netscape using the 
Netscape script located in the Acrobat 4.0/Browsers directory. Follow the instructions in the 
INSTGUIDE.TXT file to link your Netscape browser to the Acrobat 4.0 Reader with Search 
application. 
  

Web viewing scenarios 
  
Here are four possible scenarios for viewing PDF on the Web.  We use Optimized PDF files to 
download a page-at-time This is when the browser supports PDF viewing, the PDF file is 
optimized, and the Web server supports page-at-a-time downloading (byte-serving), so the PDF 
file downloads a page at a time and displays the file pages in the Web browser window. This is 
the fastest scenario possible for viewing PDF documents on the Web. 



 

 

  
There are other downloading possibilities, which we do not use on this site. 
  
  

Page-at-a-time downloading 
  
With page-at-a-time downloading (byte-serving), the Web server sends only the requested 
page of information to the user, not the entire PDF document.   
For those who want the entire document, there are other methods used to download  the entire 
document to your hard disk.   
  
As a reader of the PDF document, you do not have to do anything to make this page-at-a-time 
happen; it is communicated in the background between Acrobat Reader and the Web server. If 
you want the entire PDF document to continue downloading 
in the background while you view the first page of requested information, be sure Allow 
Background Downloading is selected in the General preferences dialog box (default). 
  

If you wish to download the entire file to your computer, right click your mouse button, and then,  

Select: Save link as... If you use Netscape or, 

Select: Save target as... If you use Internet Explorer   

After you decide where on your computer you want the file, hit "SAVE" to 
download. Once the file is on your computer double click on it to open it in Acrobat 
Reader. With this method you can open these files from your computer at anytime. 

  

Reading PDF in a Web browser 
  
PDF documents can display in Web browsers compatible with Netscape Navigator 3.0 (or later) 
or Internet Explorer 3.0 (or later). The necessary plug-ins are automatically installed when you 
install Acrobat Reader.  
  
When you view a PDF document in a Web browser, all of the Acrobat Reader tools are available 
in the browser. In Windows, you can click the two small vertical lines (next to the Adobe icon at 
the left of the toolbar) to minimize or maximize the toolbar. 
  
Note: Many keyboard commands are mapped to the Web browser rather than to Acrobat Reader, 
so some Acrobat Reader keyboard shortcuts may not be available in the browser window. 
  

Installing the Web browser plug-in 
  
Browsers compatible with Netscape Navigator need the nppdf32.dll file (Windows), the nppdf.so 
file (UNIX), or PDFViewer plug-in (Mac OS) to display PDF.  
  



 

 

When you install Acrobat Reader with Search, this plug-in is automatically installed in the 
Netscape plug-in folder (Win and Mac OS), if you have Navigator on your system. If you install 
Navigator after installing Acrobat Reader, or if you’re using another browser compatible with 
Navigator, you can install this plug-in yourself. To set up Netscape Navigator on a UNIX system, 
you must run the Netscape launch script located in the Browser folder. 
  
To manually install the Web browser plug-in (Windows): 
1 Open the Browser folder in the Acrobat Reader folder. 
2 Copy the nppdf32.dll file to your Web browser’s plug-ins folder. 
  
To manually install the Web browser plug-in (Mac OS): 
1 Open the Web Browser Plug-in folder in the Acrobat Reader folder. 
2 Copy the PDFViewer plug-in to your Web browser’s plug-ins folder. 
 
To open a PDF document that’s been downloaded onto your system: 
  
Do one of the following: 
  
Click the Open button , or choose File > Open. In the Open dialog box, select the filename for 
the file downloaded on your computer, and click Open. PDF documents usually have the 
extension .pdf. 
  
You can also choose the document’s filename from the File menu for the last four PDF 
documents you opened.  You can also Double-click the file icon in your file system. 
  
Note: In Mac OS, you may not be able to open a PDF document created in Windows by double-
clicking the icon. If double-clicking the icon in Mac OS does not open the document, use File > 
Open in Acrobat Reader to open the document, close the document, and try again. After you’ve 
used the Open command once on the document, you’ll be able to open the document next time by 
double-clicking. 
  
To display a list of all Acrobat Reader command-line options (UNIX), start the Acrobat Reader 
product with the -help option. For example:  acroread -help 
   
To manually install the Web browser plug-in (UNIX): 
Run <installdir>/Browsers/netscape. 
  

Browsing with bookmarks 
Bookmarks mark parts of a document for quick access, link to page views in other documents, 
link to the Web, play a movie or sound, enter an article, or reset or submit a form.  Primarily we 
are concerned with the sheet music at present however as this develops more features will be 
incorporated.  Essentially Bookmarks are nothing more than links to open pages inside the 
document or files outside of the document. 
  
To browse with a bookmark: 
  
1 Show the Bookmarks palette (This is the default on first opening the music files. If not, you 
may need to choose Window > Show Bookmarks to open the palette or click the Bookmarks tab 
to bring the palette to the front of its group. 
  



 

 

2 To jump to a topic using its bookmark, click the bookmark’s icon or text in the palette. 
  
Note: Clicking a bookmark might perform an action, such as playing a movie, instead of taking 
you to another location. It depends on how the bookmark was defined. 
  
The bookmark for the part of the document currently showing appears boldfaced. If the 
navigation pane disappears when you click a bookmark, the document creator has activated the 
Hide After Use command. To show the navigation pane again, click the Show Navigation Pane 
button on the command bar. Deselect Hide After Use in the navigation pane’s palette menu if you 
want the navigation pane to remain open after you click a bookmark. 
  
Bookmarks can be subordinate to other bookmarks in their hierarchy; a higher-level bookmark in 
this relationship is the parent, and a lower-level bookmark is the child.   You open these and close 
these by selecting the (+) to open or (-) to close next to the bookmark listing if in Windows and 
the Triangle in the MacOS. 
  
  
In other words, you can collapse a parent bookmark in the palette to hide all its children. When a 
parent bookmark is collapsed, it has a plus sign (Windows) or a triangle (Mac OS) next to it. If 
the bookmark you want to click is hidden in a collapsed parent, click the plus sign or triangle next 
to the parent to show it. 
  

Paging through a document 
  
Acrobat Reader provides buttons, keyboard shortcuts, and menu commands for paging through 
PDF documents. 
  
To go to another page do one of the following: 
  
To go to the next page, click the Next Page button in the command bar or status bar, press the 
Right Arrow key, press Ctrl (Windows or UNIX) or Option (Mac OS) and the Down Arrow key, 
or choose Document > Next Page. 
  
To go to the previous page, click the Previous Page button in the command bar or status bar, 
press the Left Arrow key, press Ctrl (Windows or UNIX) or Option (Mac OS) and the Up Arrow 
key, or choose Document > Previous Page. 
  
To move down one line, press the Down Arrow key. 
To move up one line, press the Up Arrow key. 
  
Note: The Down and Up Arrow keys move you one line at a time when you are in Window view. 
In Single Page mode, these keys move you one page at a time if the page fills the entire screen. 
  
To move down one screen, press Page Down or Return. 
To move up one screen, press Page Up or Shift+Return. 
  
To go to the first page, click the First Page button in the command bar or status bar, press the 
Home key, or choose Document > First Page. 
  



 

 

To go to the last page, click the Last Page button in the command bar or the status bar, press the 
End key, or choose Document > Last Page. 
  
To jump to a page by its number: 
  
Do one of the following: 
  
Select the current page number in the status bar, type the page number to jump to, and press 
Return. 
  
Choose Document > Go To Page, type the page number, and click OK. 
  
OR 
  
Drag the vertical scroll bar until the number of the page you want to jump to is displayed. 
  
To retrace your viewing path: 
  
To retrace your path within a PDF document, click the Go to Previous Viewbutton in the 
command bar, or choose Document > Go Back for each step back. Or click the Go to Next View 
button, or choose Document > Go Forward for each step forward. 
  
To retrace your viewing path through other PDF documents, choose Document > Go Back Doc 
for each step back or Document > Go Forward Doc for each step forward. Or hold down Shift, 
and click the Go Back or Go Forward button. This command opens the other PDF documents if 
the documents are closed. 
  

Visiting the Adobe Web site For additional help: 
  
Click the Adobe Web Site button to link directly to the Adobe Web site (www.adobe.com). This 
page contains valuable information about new technology, links to Acrobat plug-ins, and more. 
On the Adobe Web site home page, you can click a country name in the Adobe Sites pop-up 
menu to choose a language for viewing the site. The exact information in the site may vary from 
one language version to another. 
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This is the real meaning of the Manthra.

(Portions of a quotation of Bhagavan Sri Sathya Sai Baba, appearing in the
book, DIGEST, which is a collection of His sayings.)

3. "O Lord, bless me through Your Grace with Immortality, or
Paramananda, resulting from the awareness of the effulgence of the

Atma, immament in every object."

2. "O Lord, when the objects of this world attract me, remove the
darkness which hides the all-pervading Atma, which every such

object really is."

This Mantra is comprised of three prayers.

1. "O Lord, when I am deriving happiness through the objects of
this world, make me forget the unreal objects and show me the way

to permament happiness."

*Optional

(FROM UNTRUTH LEAD ME TO THE TRUTH)

(us)

(us)

(us)

Transcribed from a recording of BHAGAVAN SRI SATHYA SAI BABA singing this mantra.
English text adapted from various translations by Dennis Neal, USA.
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Transcribed from a recording of BHAGAVAN
SRI SATHYA SAI BABA singing this mantra.

(us)__

(us)

(FROM  UNTRUTH LEAD  ME  TO  THE  TRUTH)

(us)

This is the real meaning of the Manthra.

(Portions of a quotation of Bhagavan Sri Sathya Sai Baba, appearing in
the book, DIGEST, which is a collection of His sayings.)

3. "O Lord, bless me through Your Grace with Immortality, or
Paramananda, resulting from the awareness of the effulgence of the

Atma, immament in every object."

2. "O Lord, when the objects of this world attract me, remove the
darkness which hides the all-pervading Atma, which every such

object really is."

This Mantra is comprised of three prayers.

1. "O Lord, when I am deriving happiness through the objects of
this world, make me forget the unreal objects and show me the way

to permament happiness."
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The act of offering is Brahman, the offering itself is Brahman, offered by Brahman in the
sacred fire which is Brahman.  He alone attains Brahman who, in all his actions, is fully

absorbed in Brahman.
I am Vaishvaanaro, the all-pervading cosmic energy lodged in the bodies of living beings.

Being united with their ingoing and outgoing life-breaths, I consume all the different
(four types of) foods.

Just before taking  your food, you should pray and offer the entire meal to God in order to cleanse
and purify it. This prayer, which is offered before food, is not for the benefit of God, but it is for your

own benefit; it will purify your food by evoking God's blessing.
This prayer is taken from the Bhagavad Gita: chapter four, verse twenty-four, and, chapter fifteen,

verse fourteen.

Before offering this prayer, the food is merely food; but once you offer it to the Lord it becomes
Prasadam, consecrated food. This prayer removes all the defects and flaws in the vessels and in the

articles of food, as well as removing any negative influence acquired during the cooking process.

Melody transcribed from the recording: SATHYA SAI COLLEGE BOYS SING [Brindavan 12/1979].
[PRAYER  OF  SPIRITUAL  AWAKENING  BEFORE  TAKING  FOOD]
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[adapted from the book:c

BRAHMAAR  PANAM 



Brah-maar - pa- nam Brah -

ma Ha-vir Brah- maa - gnau Brah- ma-

naa Hu-tam Brah- ma- i - va Te - na Gan- tav- yam

Brah-ma Kar- ma Sa-maa - dhi- na ha A -

ham Va-ish-vaa - na - ro Bhu-tvaa Praa- ni- naam

[HYMN  OF  SPIRITUAL  AWAKENING  BEFORE  TAKING  FOOD]
The melody transcribed from the recording: SATHYA SAI COLLEGE BOYS SING [Brindavan

12/1979].

BRAHMAAR  PANAM   (Page 1) 
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De- ha-maa- shri- ta - ha Praa - naa -

paa - na Sa- maa Yuk - ta - ha Pa- chaa - my An - nam

Cha-tur Vid-ham

Just before taking  your food, you should pray and offer the entire
meal to God in order to cleanse and purify it. This prayer, which is
offered before food, is not for the benefit of God, but it is for your

own benefit; it will purify your food by evoking God's blessing.
This prayer is taken from the Bhagavad Gita: chapter four, verse

twenty-four, and, chapter fifteen, verse fourteen.
The act of offering is Brahman, the offering itself is Brahman,

offered by Brahman in the sacred fire which is Brahman.  He alone
attains Brahman who, in all his actions, is fully absorbed in

Brahman.
I am Vaishvaanaro, the all-pervading cosmic energy lodged in the

bodies of living beings. Being united with their ingoing and outgoing
life-breaths, I consume all the different (four types of) foods.

Before offering this prayer, the food is merely food; but once you
offer it to the Lord it becomes Prasadam, consecrated food. This
prayer removes all the defects and flaws in the vessels and in the

articles of food, as well as removing any negative influence acquired
during the cooking process. 

Copyright - All Rights Reserved.  Permission Granted for Non-Commercial Use for the Purpose of Photo-
copying the Music for Personal or Group Devotional Singing.  Recording Rights or Mass Redistribution

Rights are Not Granted for Commercial or Non-Commercial Use.  Contact the Owner of the Copyright for
Permission. The Web Site Will Not Grant Permission for Any Other Use Held by the Owner of the

Copyright.

BRAHMAAR  PANAM   (Page 2) 



   

Brah -

Cm

maar - - pa -

G7

nam Brah -

Cm

ma Ha-vir

5

____________

G7

Brah -

Cm

maa - -

Fm6

gnau Brah-ma -

G

naa Hu-tam

9

_____________ Brah -

Cm

ma- i - va Te - na

Fm6

Gan - tav - yam

G7

13 G

Brah-ma Kar-ma

Cm G

Sa-maa-dhi-na-ha A -

Cm

ham Va-ish-vaa-na -

17 Fm6

ro Bhu-tvaa

G7 Cm

Praa - ni-naam

3 Fm6

De - ha-maa - shri-ta -

21 G7

ha Praa -

Cm

naa - paa- na Sa-maa Yuk -

Fm6 G7

ta - ha

26

Pa - chaa - my An - nam

Fm6 G7

Cha- tur Vi-dham

Cm

29 Cm

Om
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BRAHMAAR  PANAM 
Key of C minor

(PRAYER  OF  SPIRITUAL  AWAKENING  BEFORE  TAKING  FOOD)
Melody transcribed from the recording: SATHYA SAI COLLEGE BOYS SING [Brindavan 12/1979]. 

Just before taking  your food, you should pray and offer the entire meal to God in order to cleanse and
 purify it. This prayer, which is offered before food, is not for the benefit of God, but it is for your

 own benefit; it will purify your food by evoking God's blessing. This prayer is taken from 
the Bhagavad Gita: chapter four, verse twenty-four, and, chapter fifteen, verse fourteen.

 The act of offering is Brahman, the offering itself is Brahman, offered by Brahman in the sacred fire 
which is Brahman.  He alone attains Brahman who, in all his actions, is fully absorbed in Brahman. 

I am Vaishvaanaro, the all-pervading cosmic energy lodged in the bodies of living beings. Being united 
with their ingoing and outgoing life-breaths, I consume all the different (four types of) foods.

Before offering this prayer, the food is merely food; but once you offer it to the Lord it becomes 
Prasadam, consecrated food. This prayer removes all the defects and flaws in the vessels and in 

the articles of food, as well as removing any negative influence acquired during the cooking process.
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Brah - maar - pa - nam Brah-

5

ma Ha-vir Brah - maa - - - gnau Brah-ma-

9

naa Hu-tam Brah - ma-i - va Te - na Gan-tav-yam

13

____________ Brah-ma Kar-ma Sa-maa-dhi-na-ha A -

17

ham Va - ish-vaa - na - ro Bhu - tvaa

BRAHMAAR  PANAM 

Key of C minor

(PRAYER  OF  SPIRITUAL  AWAKENING  BEFORE  TAKING  FOOD)
Melody transcribed from the recording: SATHYA SAI COLLEGE BOYS SING [Brindavan 12/1979]. 



20

Praa - ni-naam

3

De - ha-maa - shri-ta - ha Praa -

24

naa - - - - paa - na Sa-maa Yuk - ta - ha

27

Pa - chaa - my An - nam Cha-tur Vi-dham

30

Om Shan - thi, Shan - thi, Shan - th-i

BRAHMAAR  PANAM         p. 2

Just before taking  your food, you should pray and offer the entire meal to God in order to cleanse and
 purify it. This prayer, which is offered before food, is not for the benefit of God, but it is for your

 own benefit; it will purify your food by evoking God's blessing. This prayer is taken from 
the Bhagavad Gita: chapter four, verse twenty-four, and, chapter fifteen, verse fourteen.

 The act of offering is Brahman, the offering itself is Brahman, offered by Brahman in the sacred fire 
which is Brahman.  He alone attains Brahman who, in all his actions, is fully absorbed in Brahman. 

I am Vaishvaanaro, the all-pervading cosmic energy lodged in the bodies of living beings. Being united 
with their ingoing and outgoing life-breaths, I consume all the different (four types of) foods.

Before offering this prayer, the food is merely food; but once you offer it to the Lord it becomes 
Prasadam, consecrated food. This prayer removes all the defects and flaws in the vessels and in 

the articles of food, as well as removing any negative influence acquired during the cooking process.
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Translation: 
God hear my song!   (=Om)
I live in this world with Baba   (=Bhur Baba)
God I am very happy   (=Om)

œ
œ œ œ

Om Bhur Ba - ba

œ
œ œ œ

Om Bhur Ba - ba

w

Om.

Children's Mantra
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Melody and text authored by Kees Vermeulen Windsant, Luxembourg

First line may be sung by boys, second by girls
Can be sung as a canon too



Aum Bhur Bhu - vah Su - va - ha

Tat Sa - vi - tur Va - re - nium Bar - go De - vas - ya

Dhee-ma - he Dhi - yo Yo Nah Pra- cho - day -

Repeat 3 times

at

This melodic notation was transcribed from a recording of
BHAGAVAN  SRI  SATHYA  SAI  BABA  teaching this mantra to a large

gathering of students.  It was sung in a rote fashion, with Baba
singing a phrase, and the students repeating it.  It was sung through

three times. The harmonization is submitted by the transcriber.

A Translation:
We meditate on that Supreme Effulgence of the Radiant Being

...the indwelling Controller and Director of all things.
May He stimulate our intellect entirely (to realize the Truth).

The GAYATHRI is the universal prayer inshrined in the Vedas, the
most ancient scriptures of man.  It is addressed to the Immanent and
Transcendent Divine which has been given the name "Savitha" which

means, 'that from which all this is born'.
The GAYATHRI may be considered as having three parts.

1. PRAISE...the Divine is praised and glorified.
2. MEDITATION...with reverence the Divine is contemplated.

3. PRAYER...an appeal is made to the Divine to awaken and
strengthen the discriminating faculty of man...the intellect.

  is requesting,
  urging, praying.

Yo Nah Prachodayat

Bhargo   represents
  radiance, luster
  and illumination.
Devasya is divine grace.
Dheemahi means
  we contemplate.
Dhiyo stands for  intellect.

Tat   stands for THAT.
  The Ultimate Reality is
  referred to as THAT
  because it defies
  description through
  speech or language
Savitur   stands for the
  divine SAVITRI, the life
  giving power contained
  in the sun.
Varenium  is to adore.

Aum or Om  represents
  sound as the basis of creation.
Bhur  represents
  the earth, the gross.
Bhuvah  represents the
  atmosphere, the ether,
  the subtle.
Suvah  represents heaven,
  the region beyond
  BHUVAH, the casual.

(Revised 31 Mar 1998)
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Repeat 3 times

at

The GAYATHRI is the universal prayer inshrined in the Vedas, the most
ancient scriptures of man.  It is addressed to the Immanent and

Transcendent Divine which has been given the name "Savitha" which
means, 'that from which all this is born'.

The GAYATHRI may be considered as having three parts.
1. PRAISE...the Divine is praised and glorified.

2. MEDITATION...with reverence the Divine is contemplated.
3. PRAYER...an appeal is made to the Divine to awaken and

strengthen the discriminating faculty of man...the intellect.
This melodic notation was transcribed from a recording of

BHAGAVAN  SRI  SATHYA  SAI  BABA  teaching this mantra to a
large gathering of students.  It was sung in a rote fashion, with

Baba singing a phrase, and the students repeating it.  It was
sung through three times.   The harmonization is submitted by

the transcriber.

A Translation:
We meditate on that Supreme Effulgence of the

Radiant Being
...the indwelling Controller and Director of all

things.
May He stimulate our intellect entirely (to realize

the Truth).

Yo Nah Prachodayat

(Revised - 31 March 1998)

Aum or Om  represents
  sound as the basis of creation.
Bhur represents
  the earth, the gross.
Bhuvah represents the
  atmosphere, the ether,
  the subtle.
Suvah represents heaven,
  the region beyond
  BHUVAH, the casual.

Tat stands for THAT. The
  Ultimate Reality is referred
  to as THAT because it defies
  description through
  speech or language
Savitur  stands for the
  divine SAVITRI, the life
  giving power contained
  in the sun.
Varenium  is to adore.

Bhargo  represents
  radiance, luster
  and illumination.
Devasya is divine grace.
Dheemahi means
  we contemplate.
Dhiyo stands for  intellect.

  is requesting,
  urging, praying.
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 Omkar (21 Oms)

❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍

ORGANS OF ACTION:
1. Vocal Chords,  2. Hands,  3. Feet,  4. Elimination Organs,

and 5. Generative Organs

ORGANS OF PERCEPTION:
6. Eye,  7. Ear,  8. Nose,   9. Tongue,  and   10.  Skin

VITAL AIRS OF THE BODY:
11. Prana (located in the lungs)

12. Apana (flatus, which moves downward through the rectum)
13. Vyana (diffused throughout the whole body)

14. Samana (located near the navel and is essential to digestion)
15. Udana (which rises through throat to the head)

THE FIVE SHEATHS ENCASING THE BODY:
16. Material Sheath,  17. Sheath of vital air,

18. Mental-emotional Sheath,  19. Sheath of intellect, 20. Sheath of bliss

21. Self-Realization

omomomomomomomomomomomomomomomomomomomomom

Shanti,  Shanti,  Shanti!
❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍❍

Recitation of Omkar, or Pranava (OM), is a daily practice at Prasanthi Nilayam
(Bhagavan Sri Sathya Sai Baba’s residence in India). It takes place during the early
morning hours and is repeated 21 times.  Although the number is not arbitrarily fixed,
the recitation of OM for each of the twenty  components listed above, purifies and
clarifies them, with the recitation of  the twenty-first OM culminating in preparing  the
whole person for merger with the the Supreme Absolute (Self-Realization).  The
Pranava recital concludes with the recitation of ‘Santhi’ (Peace) three times, for
further clarification and purification of the body, mind and spirit. This Pranava
recitation will tone you up and calm down the agitations in the mind and quicken the
downpour of Grace.

The Pranava (OM) is the original, basic sound from which all other sound
emanates. It is the sound of the supreme universal reality called Brahmam. It is the
fusion of three primal sounds: A, U, and M. The ‘A’ represents the ‘waking state’
(jagrat); the ‘U’ represents the ‘dream state’ (swapna); and the ‘M’ symbolizes the ‘deep
sleep state’ (sushupti). As in the chanting of A-U-M the letters change from A to M but
the breath remains constant throughout. Similarly the states of consciousness change
from waking to dreaming to deep sleep, but the one self (Atma) is always present.
Listen to the primeval Pranava resounding in your heart as well as in the heart of the
universe.

(The above information culled from quotes of Sathya Sai Baba.)
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(An instrumental accompaniment)

Text: God;
Music: authored by
Dennis Neal, USA.
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Part C  is written for the keyboard and can be used nicely
without utilizing parts A and/or B.

This is an accompaniment designed to be used with the singing
of the 'Omkar'. Its composition reflects the harmonies and styles
of the Western culture's musical formats in a traditional sense.

SUGGESTIONS:
Part A  could be played by a solo instrument ( a flute, French
horn, or such) as it is a counter melody which floats over the

one toned OM sound.
Part B  is a metered 'arpeggio style' musical line that could be

played on a harp or guitar. It is designed rhythmically to guide
the singers through the OMKAR with a marked, steady pace.
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C Am

Om Na-mah Shi - va - ya
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Om Na-mah Shi - va - ya
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11
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Om Na-mah Shi - va - ya

G7 C

Om Na-mah Shi - va - ya

OM  NAMAH  SHIVAYA  MANTRA
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Om,

Shan -
Peace,

thi Shan -
Peace,

thi Shan-
Peace.

thi
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Key of C minor 
(Melody transcribed as sung by the students at Prashanthi Nilayam, August, 2008)

SAMASTHA  LOKAH  SUKHINO  BHAVANTHU
Accompaniment version

If you sing the Arathi Song in the key of G use this rendition

If you sing the Arathi Song in the kiey of G use this rendition

Key of C minor 



    

E m6

Sa -
May

mas-
all

tha
the

Lo -
be -

F7

kah
ings

Suk -
of

hi -
the

B m E m

no
worlds

Bha-
be

van -
bliss -

F

thu
ful.

5 E m6

Sa -
May

mas-
all

tha
the

Lo -
be -

F7

kah
ings

Suk -
of

hi -
the

B m E m

no
worlds

Bha -
be

van -
bliss -

F

thu
ful.

9 E m6

Sa -
May

mas-
all

tha
the

Lo -
be -

F7

kah
ings

Suk -
of

hi -
the

B m E m

no
worlds

Bha -
be

van -
bliss -

F

thu
ful.

13 B m

Om
Om,

E m

Shan -
Peace,

thi

B m E m

Shan -
Peace,

thi

B m E m

Shan-
Peace.

thi

F7 B m

20
Repeat three times

Sa -
May
Sa - mas-

all
tha
the

Lo -
be -

kah
ings

Suk -
of

hi -
the

no
worlds

Bha-
be

van-
bliss-

thu
ful.

24

Om
Om,

Shan -
Peace,

thi Shan -
Peace,

thi Shan-
Peace.

thi
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Key of B flat minor 
(Melody transcribed as sung by the students at Prashanthi Nilayam, August, 2008)

SAMASTHA  LOKAH  SUKHINO  BHAVANTHU
Accompaniment version

If you sing the Arathi Song in the key of F use this rendition

If you sing the Arathi Song in the key of F use this rendition

Key of B flat minor 



    

Dm6

Sa -
May
Sa - mas-

all
tha
the

Lo -
be -

E7

kah
ings

Suk -
of

hi -
the

Am Dm

no
worlds

Bha -
be

van -
bliss -

E

thu
ful.

5 Dm6

Sa -
May

mas -
all

tha
the

Lo -
be -

E7

kah
ings

Suk -
of

hi -
the

Am Dm

no
worlds

Bha -
be

van -
bliss -

E

thu
ful.

9 Dm6

Sa -
May

mas -
all

tha
the

Lo -
be -

E7

kah
ings

Suk -
of

hi -
the

Am Dm

no
worlds

Bha -
be

van -
bliss -

E

thu
ful.

13 Am

Om
Om,

Dm

Shan -
Peace,

thi

Am Dm

Shan -
Peace,

thi

Am Dm

Shan-
Peace.

thi

E7 Am

20
Repeat three times

Sa -
May
Sa -

May
mas-
all

tha
the

Lo -
be -

kah
ings

Suk -
of

hi -
the

no
worlds

Bha-
be

van-
bliss-

thu
ful.

24

Om
Om,

Shan -
Peace,

thi Shan -
Peace,

thi Shan-
Peace.

thi
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Key of A minor 
(Melody transcribed as sung by the students at Prashanthi Nilayam, August, 2008)

SAMASTHA  LOKAH  SUKHINO  BHAVANTHU
Accompaniment version

If you sing the Arathi Song in the key of E use this rendition

If you sing the Arathi Song in the key of E use this rendition

Key of A  minor 



    

D m6

Sa -
May
Sa - mas-

all
tha
the

Lo -
be -

E 7

kah
ings

Suk -
of

hi -
the

A m D m

no
worlds

Bha-
be

van -
bliss -

E

thu
ful.

5 D m6

Sa -
May

mas-
all

tha
the

Lo -
be -

E 7

kah
ings

Suk -
of

hi -
the

A m D m

no
worlds

Bha-
be

van -
bliss -

E

thu
ful.

9 D m6

Sa -
May

mas-
all

tha
the

Lo -
be -

E 7

kah
ings

Suk -
of

hi -
the

A m D m

no
worlds

Bha-
be

van -
bliss -

E

thu
ful.

13 A m

Om
Om,

D m

Shan -
Peace,

thi

A m D m

Shan -
Peace,

thi

A m D m

Shan-
Peace.

thi

E 7 A m

20
Repeat three times

Sa-
May
Sa-

May
mas-
all

tha
the

Lo -
be -

kah
ings

Suk -
of

hi -
the

no
worlds

Bha-
be

van-
bliss-

thu
ful.

24

Om
Om,

Shan -
Peace,

thi Shan-
Peace,

thi Shan-
Peace.

thi

SAMASTHA  LOKAH  SUKHINO  BHAVANTHU

 Copyright - All Rights Reserved.  Permission Granted for Non-Commercial Use for the Purpose of Photo-copying the 
Music for Personal or Group Devotional Singing.  Recording Rights or Mass Redistribution Rights are Not Granted for 

Commercial or Non-Commercial Use.  Contact the Owner of the Copyright for Permission. The Web Site Will Not 
Grant Permission for Any Other Use Held by the Owner of the Copyright.

Key of A flat minor 
(Melody transcribed as sung by the students at Prashanthi Nilayam, August, 2008)

SAMASTHA  LOKAH  SUKHINO  BHAVANTHU
Accompaniment version

If you sing the Arathi Song in the key of E flat use this rendition

If you sing the Arathi Song in the key of E flat use this rendition

Key of A flat minor 



    

Cm6

Sa -
May
Sa -Sa - mas-

all
tha
the

Lo -
be -

D7

kah
ings

Suk -
of

hi -
the

Gm Cm

no
worlds

Bha-
be

van -
bliss -

D

thu
ful.

5 Cm6

Sa -
May

mas-
all

tha
the

Lo -
be -

D7

kah
ings

Suk -
of

hi -
the

Gm Cm

no
worlds

Bha -
be

van -
bliss -

D

thu
ful.

9 Cm6

Sa -
May

mas-
all

tha
the

Lo -
be -

D7

kah
ings

Suk -
of

hi -
the

Gm Cm

no
worlds

Bha -
be

van -
bliss -

D

thu
ful.

13 Gm

Om
Om,

Cm

Shan -
Peace,

thi

Gm Cm

Shan -
Peace,

thi

Gm Cm

Shan-
Peace.

thi

D7 Gm

20
Repeat three times

Sa -
May
Sa -

May
Sa - mas-

all
tha
the

Lo -
be -

kah
ings

Suk -
of

hi -
the

no
worlds

Bha-
be

van-
bliss-

thu
ful.

24

Om
Om,

Shan -
Peace,

thi Shan -
Peace,

thi Shan-
Peace.

thi
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Key of G minor 
(Melody transcribed as sung by the students at Prashanthi Nilayam, August, 2008)

SAMASTHA  LOKAH  SUKHINO  BHAVANTHU
Accompaniment version

If you sing the Arathi Song in the key of D use this rendition

If you sing the Arathi Song in the key of D use this rendition

Key of G  minor 



    

D m6

Sa -
May
Sa - mas-

all
tha
of

Lo -
the

E 7

kah
be-ings

Suk -
of

hi -
the

A m D m

no
worlds

Bha-
be

van -
bliss -

E

thu
ful.

5 D m6

Sa -
May

mas-
all

tha
of

Lo -
the

E 7

kah
be-ings

Suk -
of

hi -
the

A m D m

no
worlds

Bha-
be

van -
bliss -

E

thu
ful.

9 D m6

Sa -
May

mas-
all

tha
of

Lo -
the

E 7

kah
be-ings

Suk -
of

hi -
the

A m D m

no
worlds

Bha-
be

van -
bliss -

E

thu
ful.

13 A m

Om
Om,

D m

Shan -
Peace,

thi

A m D m

Shan -
Peace,

thi

A m D m

Shan-
Peace.

thi

E 7 A m

20
Repeat three times

Sa-
May
Sa-

May
mas-
all

tha
of

Lo -
the

kah
be-ings

Suk -
of

hi -
the

no
worlds

Bha-
be

van-
bliss-

thu
ful.

24

Om
Om,

Shan -
Peace,

thi Shan-
Peace,

thi Shan-
Peace.

thi
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Key of A flat minor 
(Melody transcribed as sung by the students at Prashanthi Nilayam, August, 2008)

SAMASTHA  LOKAH  SUKHINO  BHAVANTHU
Accompaniment version

If you sing the Arathi Song in the key of E flat use this rendition

If you sing the Arathi Song in the key of E flat use this rendition

Key of A flat minor 



    

Dm6

Sa -
May
Sa - mas-

all
tha
of

Lo -
the

E7

kah
be-ings

Suk -
of

hi -
the

Am Dm

no
worlds

Bha -
be

van -
bliss -

E

thu
ful.

5 Dm6

Sa -
May

mas -
all

tha
of

Lo -
the

E7

kah
be - ings

Suk -
of

hi -
the

Am Dm

no
worlds

Bha -
be

van -
bliss -

E

thu
ful.

9 Dm6

Sa -
May

mas -
all

tha
of

Lo -
the

E7

kah
be - ings

Suk -
of

hi -
the

Am Dm

no
worlds

Bha -
be

van -
bliss -

E

thu
ful.

13 Am

Om
Om,

Dm

Shan -
Peace,

thi

Am Dm

Shan -
Peace,

thi

Am Dm

Shan-
Peace.

thi

E7 Am

20
Repeat three times

Sa -
May
Sa -

May
mas-
all

tha
of

Lo -
the

kah
be- ings

Suk -
of

hi -
the

no
worlds

Bha-
be

van-
bliss-

thu
ful.

24

Om
Om,

Shan -
Peace,

thi Shan -
Peace,

thi Shan-
Peace.

thi
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Key of A minor 
(Melody transcribed as sung by the students at Prashanthi Nilayam, August, 2008)

SAMASTHA  LOKAH  SUKHINO  BHAVANTHU
Accompaniment version

If you sing the Arathi Song in the key of E use this rendition

If you sing the Arathi Song in the key of E flat use this rendition

Key of A  minor 



    

E m6

Sa -
May

mas-
all

tha
of

Lo -
the

F7

kah
be-ings

Suk -
of

hi -
the

B m E m

no
worlds

Bha-
be

van -
bliss -

F

thu
ful.

5 E m6

Sa -
May

mas-
all

tha
of

Lo -
the

F7

kah
be-ings

Suk -
of

hi -
the

B m E m

no
worlds

Bha -
be

van -
bliss -

F

thu
ful.

9 E m6

Sa -
May

mas-
all

tha
of

Lo -
the

F7

kah
be-ings

Suk -
of

hi -
the

B m E m

no
worlds

Bha -
be

van -
bliss -

F

thu
ful.

13 B m

Om
Om,

E m

Shan -
Peace,

thi

B m E m

Shan -
Peace,

thi

B m E m

Shan-
Peace.

thi

F7 B m

20
Repeat three times

Sa -
May
Sa - mas-

all
tha
of

Lo -
the

kah
be- ings

Suk -
of

hi -
the

no
worlds

Bha-
be

van-
bliss-

thu
ful.

24

Om
Om,

Shan -
Peace,

thi Shan -
Peace,

thi Shan-
Peace.

thi
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Key of B flat minor 
(Melody transcribed as sung by the students at Prashanthi Nilayam, August, 2008)

SAMASTHA  LOKAH  SUKHINO  BHAVANTHU
Accompaniment version

If you sing the Arathi Song in the key of F use this rendition

If you sing the Arathi Song in the key of F use this rendition

Key of B flat minor 



    

Fm6

Sa -
May

mas-
all

tha
of

Lo -
the

G7

kah
be-ings

Suk -
of

hi -
the

Cm Fm

no
worlds

Bha -
be

van -
bliss -

G

thu
ful.

5 Fm6

Sa -
May

mas-
all

tha
of

Lo -
the

G7

kah
be-ings

Suk -
of

hi -
the

Cm Fm

no
worlds

Bha -
be

van -
bliss -

G

thu
ful.

9 Fm6

Sa -
May

mas-
all

tha
of

Lo -
the

G7

kah
be-ings

Suk -
of

hi -
the

Cm Fm

no
worlds

Bha -
be

van -
bliss -

G

thu
ful.

13 Cm

Om
Om,

Fm

Shan -
Peace,

thi

Cm Fm

Shan-
Peace,

thi

Cm Fm

Shan-
Peace.

thi

G7 Cm

20
Repeat three times

Sa -
May

mas-
all

tha
of

Lo -
the

kah
be-ings

Suk -
of

hi -
the

no
worlds

Bha-
be

van-
bliss-

thu
ful.

24

Om
Om,

Shan -
Peace,

thi Shan -
Peace,

thi Shan-
Peace.

thi
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Key of C minor 
(Melody transcribed as sung by the students at Prashanthi Nilayam, August, 2008)

SAMASTHA  LOKAH  SUKHINO  BHAVANTHU
Accompaniment version

If you sing the Arathi Song in the key of G use this rendition

If you sing the Arathi Song in the kiey of G use this rendition

Key of C minor 



    

B m6

Sa -
May
Sa -Sa - mas-

all
tha
of

Lo -
the

C7

kah
be-ings

Suk -
of

hi -
the

Fm B m

no
worlds

Bha-
be

van -
bliss -

C

thu
ful.

5 B m6

Sa -
May

mas-
all

tha
of

Lo -
the

C7

kah
be-ings

Suk -
of

hi -
the

Fm B m

no
worlds

Bha -
be

van -
bliss -

C

thu
ful.

9 B m6

Sa -
May

mas-
all

tha
of

Lo -
the

C7

kah
be-ings

Suk -
of

hi -
the

Fm B m

no
worlds

Bha -
be

van -
bliss -

C

thu
ful.

13 Fm

Om
Om,

B m

Shan-
Peace,

thi

Fm B m

Shan-
Peace,

thi

Fm B m

Shan-
Peace.

thi

C7 Fm

20
Repeat three times

Sa -
May
Sa -

May
Sa - mas-

all
tha
of

Lo -
the

kah
be-ings

Suk -
of

hi -
the

no
worlds

Bha-
be

van-
bliss-

thu
ful.

24

Om
Om,

Shan -
Peace,

thi Shan -
Peace,

thi Shan-
Peace.

thi
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Key of F minor 
(Melody transcribed as sung by the students at Prashanthi Nilayam, August, 2008)

SAMASTHA  LOKAH  SUKHINO  BHAVANTHU
Accompaniment version

If you sing the Arathi Song in the key of D use this rendition

If you sing the Arathi Song in the key of D use this rendition

Key of F  minor 



    

B m6

Sa -
May
Sa -Sa - mas-

all
tha
of

Lo -
the

C7

kah
be-ings

Suk -
of

hi -
the

Fm B m

no
worlds

Bha-
be

van -
bliss -

C

thu
ful.

5 B m6

Sa -
May

mas-
all

tha
of

Lo -
the

C7

kah
be-ings

Suk -
of

hi -
the

Fm B m

no
worlds

Bha -
be

van -
bliss -

C

thu
ful.

9 B m6

Sa -
May

mas-
all

tha
of

Lo -
the

C7

kah
be-ings

Suk -
of

hi -
the

Fm B m

no
worlds

Bha -
be

van -
bliss -

C

thu
ful.

13 Fm

Om
Om,

B m

Shan-
Peace,

thi

Fm B m

Shan-
Peace,

thi

Fm B m

Shan-
Peace.

thi

C7 Fm

20
Repeat three times

Sa -
May
Sa -

May
Sa -Sa - mas-

all
tha
of

Lo -
the

kah
be- ings

Suk -
of

hi -
the

no
worlds

Bha-
be

van-
bliss-

thu
ful.

24

Om
Om,

Shan -
Peace,

thi Shan -
Peace,

thi Shan-
Peace.

thi
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Key of F minor 
(Melody transcribed as sung by the students at Prashanthi Nilayam, August, 2008)

SAMASTHA  LOKAH  SUKHINO  BHAVANTHU
Accompaniment version

If you sing the Arathi Song in the key of C use this rendition

If you sing the Arathi Song in the key of  C use this rendition

Key of F  minor 



    

Cm6

Sa -
May
Sa -Sa - mas-

all
tha
of

Lo -
the

D7

kah
be-ings

Suk -
of

hi -
the

Gm Cm

no
worlds

Bha-
be

van -
bliss -

D

thu
ful.

5 Cm6

Sa -
May

mas-
all

tha
of

Lo -
the

D7

kah
be-ings

Suk -
of

hi -
the

Gm Cm

no
worlds

Bha -
be

van -
bliss -

D

thu
ful.

9 Cm6

Sa -
May

mas-
all

tha
of

Lo -
the

D7

kah
be-ings

Suk -
of

hi -
the

Gm Cm

no
worlds

Bha -
be

van -
bliss -

D

thu
ful.

13 Gm

Om
Om,

Cm

Shan -
Peace,

thi

Gm Cm

Shan -
Peace,

thi

Gm Cm

Shan-
Peace.

thi

D7 Gm

20
Repeat three times

Sa -
May
Sa -

May
Sa - mas-

all
tha
of

Lo -
the

kah
be- ings

Suk -
of

hi -
the

no
worlds

Bha-
be

van-
bliss-

thu
ful.

24

Om
Om,

Shan -
Peace,

thi Shan -
Peace,

thi Shan-
Peace.

thi
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Key of G minor 
(Melody transcribed as sung by the students at Prashanthi Nilayam, August, 2008)

SAMASTHA  LOKAH  SUKHINO  BHAVANTHU
Accompaniment version

If you sing the Arathi Song in the key of D use this rendition

If you sing the Arathi Song in the key of D use this rendition

Key of G  minor 



    

Gm

Om Saa-yeesh - va Raa - ya

Cm

Vidh-ma - he Sath- ya

4
Adim D

Dhe-vaa - ya Dhee - ma -

Gm

hi Than - nah Sar - vah Pra -

7
Cm

cho - dha - yaa - - - -

D7 Gm

the

SATHYA  SAI  GAYATRI
Key of G minor

(Melody transcribed as sung by Sri Ravi Kumar on YouTube)

Om: the first sound of the supreme being, Brahman: the origin of creation.
We realize that Sai is God.

We meditate on this God of Truth.
We pray that He leads us to Enlightenment and Liberation.
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SATHYA  SAI  GAYATRIKey of G minor
(Melody transcribed as sung by Sri Ravi Kumar on YouTube)

Om: the first sound of the supreme being, Brahman: the origin of creation.
We realize that Sai is God. We meditate on this God of Truth.
We pray that He leads us to Enlightenment and Liberation.
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SATHYA  SAI  GAYATRI
Key of A minor

(Melody transcribed as sung by Sri Ravi Kumar on YouTube)

Om: the first sound of the supreme being, Brahman: the origin of creation.
We realize that Sai is God.

We meditate on this God of Truth.
We pray that He leads us to Enlightenment and Liberation.
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E7 Am

the

SATHYA  SAI  GAYATRIKey of A minor
(Melody transcribed as sung by Sri Ravi Kumar on YouTube)

Om: the first sound of the supreme being, Brahman: the origin of creation.
We realize that Sai is God. We meditate on this God of Truth.
We pray that He leads us to Enlightenment and Liberation.
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C

tion.

As sacred prasad, it (vibuthi) is taken for the healing of sickness; physical,
mental, emotional, spiritual. It is symbolic of the ultimate reality which

remains when the dross of ego is burnt away by the fire of illumination.  It
is the symbol of detachment, vibuthi bushana, where Siva, as the great

ascetic, covers His body with ashes.

(a quote from: SATHYA SAI SPEAKS Vol. V ~ p. 260)

A quote from: TRANSLATIONS BY BABA ~ p.180 ~ (Youngs)

Text copied from Baba's vibhuti packet.
English text and  melody provided by
the South Miami, Florida Sai devotees.

Harmonizations submitted by
the transcriber. (3 April 1998)

"The vibhuti which you smear on your forehead is intended to
convey this basic spiritual lesson.....that EVERYTHING will be

reduced to ashes, including the brow that wears it."
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Pa - ra- mam Pa - vi - thram Baa - baa Vi - bhoo - thim

Pa - ra- mam Vi - chi - thram Lee - laa Vi - bhoo - thim

Pa - ra- mar - tha Ish - tar - tha Mok - sha Pra - dha - nam

Baa - baa Vi - bhoo - thim E - da- mahs - ra Yaa - mi

Sa- cred ash, mi - rac - u- lous, Ba - ba's cre - a - tion,

Flow-ing from His bless- ing hands, ho - ly cre - a - tion,

Grant- ing us the great- est wealth, God's di- vine pro - tec - tion,

Be - lov - ed Ba - ba, grant us lib - er - a - tion.
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Text copied from Baba's vibhuthi packet. The English text and melody
transcribed as sung weekly by the South Miami Sai Center, Florida, USA.

VIBHOOTHI  MANTHRAM  (2nd version)
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Am Am Dm C/G G7 C F/C C

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

3. Om  Sri
3. Om  Sri

7. Om  Sri
7. Om  Sri

8. Om  Sri
8. Om  Sri

5. Om  Sri
5. Om  Sri

10. Om  Sri
10. Om  Sri

2. Om  Sri
2. Om  Sri

4. Om  Sri
4. Om  Sri

Sa - i, You are the Giver of Boons which promote inner development,
Sa - i, Varadaaya.....................................................................................

Sai, Your Mission is the revival of Truth and Righteousness,
Sai, Sathya Dharma Paraayanaaya.......................................

Sai, You are the Embodiment of Truth,
Sai, Sathya Svaroopaaya......................

1.  Om  Sri  Sai,
1.  Om  Sri  Sai,

6.  Om  Sri  Sai,
6.  Om  Sri  Sai,

Sa - i,  You are the One who knows everything,
Sa - i,  Sarvajnaaya..............................................

Sai, You are the Protector and Sustainer of all good people,
Sai, Sadhujana Poshanaaya....................................................

Sai, You promote righteousness, piety and perfection,
Sai, Sadhu Vardhanaaya................................................

9. Om  Sri
9. Om  Sri

You are our Divine Mother, Divine Father and Divine
Sathya Sai Baa-..............................................................

You are the Embodiment of all virtuous qua-
Sathya Gunaath............................................

Sa - i, You....are the Universal Eternal....Abso..-..lute,
Sa - i,  Sat...................... Puru-...................shaa..-..ya.

Sa - i, You.......are the Beloved of......every-one,
Sa - i, Sarva...........Jana Pri-............yaa..-..ya

The English translation was authored by Rameesh & Ananda Kasturi of India in the booklet:
A BOUQUET OF108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHY SAI BABA.

The melody was transcribed as sung weekly by the Sai Center of South Miami, Florida, USA.
Harmonizations submitted by the transcriber. (13 April 1998)
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

19. Om  Sri
19. Om  Sri

15. Om  Sri
15. Om  Sri

20. Om  Sri
20. Om  Sri

21. Om Sri Sai,
21. Om Sri Sai,

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

13. Om  Sri
13. Om  Sri

18. Om  Sri
18. Om  Sri

16. Om Sri Sai,
16. Om Sri Sai,

12. Om  Sri
12. Om  Sri

17. Om  Sri
17. Om  Sri

11. Om  Sri  Sai,
11. Om  Sri  Sai,

Sai, You are the Supreme Manifestation of All Godheads,
Sai, Sarveshaaya..................................................................

Sai, You are the One without attachment,
Sai, Sarva Sanga Parithyaagine...............

Sa - i,  You are the Indweller in everyone's heart,
Sa - i,  Sarva Antharyaamine................................

14. Om  Sri
14. Om  Sri

Sai, You have manifested Yourself in the village Puttaparthi,
Sai, Parthi Gramodbhavaaya...................................................

Sai, You are Omnipresent while Your physical body resides in Holy
Sai, Parthi Kshethra Nivaasine............................................................

Parthi,
...........

Sa - i,  Your glory and fame is the same as that of Shirdi Sai Baba,
Sa - i,  Yasahkaaya Shirdi Vaasine...................................................

You are the Motivator of all Universal En-
Sarva Shakthi Moor..................................

You are the Supreme Lord Shiva, the Embodiment of Aus-pi-
Mahesvara Svaroo.......................................................................

Na-ma-hah....
Na-ma-hah....

Bhaarad-
.............

Sa - i, You....are the Personification of....Glo-ry,
Sa - i, Ma.........-.............hima.......-.........atma-ne

Sa - i, You.... assumed the form and name: "Jodi Adipalli..So-mappa",
Sa - i, Jodi..................................Aadipalli......................Somap-paaya

You have taken human form in the religious kin-group of Sage
Bhaaradvaaja Rishi Go-.................................................................
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24. Om  Sri
24. Om  Sri

23. Om  Sri
23. Om  Sri

22. Om  Sri
22. Om  Sri

25. Om  Sri
25. Om  Sri

27. Om  Sri
27. Om  Sri

32. Om  Sri
32. Om  Sri

30. Om  Sri
30. Om  Sri

28. Om  Sri
28. Om  Sri

29. Om  Sri
29. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are affectionate towards Your devotees like a mother,
Sai, Bhaktha Vathsalaaya............................................................

Sai, You are the Innermost Self in every being,
Sai, Apaantharaathmane...................................

Sa - i,  You are all Forms of God incarnated in one,
Sa - i, Avathaara Moortaye.......................................

Sai, You grant us the freedom from fear,
Sai, Abhaya Pradaaya..............................

Sai, You have willed to take birth in the Ratnakara descendants,
Sai, Ratnaakara Vamshodhavaaya.................................................

Sai, You are still The Resident of "Dwarakamayi",
Sai, Dwaarakaamaayi Vaasine.............................

...................................................traditional school of spiritual
Aapasthamba Su....................................................................

You chose to be born in the lineage of Sage Apasthamba's....

31. Om Sri  Sai,
31. Om Sri  Sai,

You are the re-incarnation of Shirdi Sai
Shirdi Sai Moor........................................

Sa - i, You.............save us from.........all...fears,
Sa - i, Sarva...............Bhaya..........Nivaa-rine

26. Om  Sri   Sai,

26. Om  Sri   Sai,

Sa - i, You...confer happiness & prosperity upon...your devotees,
Sa - i, Sham.............-..............karaa...........-..............ya.................

Sa - i,  Your magnificence is identical to that of Shirdi Sai Baba,
Sa - i,  Shirdi Sai Abheda Shaktyaavathaaraaya.......................
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36. Om   Sri    Sai,
36. Om   Sri    Sai,

37. Om  Sri
37. Om  Sri

35. Om  Sri
35. Om  Sri

40. Om  Sri
40. Om  Sri

33. Om  Sri
33. Om  Sri

38. Om  Sri
38. Om  Sri

39. Om  Sri
39. Om  Sri

34. Om  Sri
34. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You moved about on the banks of the Chitravathi River in Parthi,
Sai, Chithraavathee Thata Puttaparthi Vihaarine.................................

Sa - i,  You bestow vigor, energy, intelligence & divine power on us,
Sa - i,  Shakthi Pradaaya......................................................................

Sai, You are the Granter of Eternal Joy,
Sai,  Aananda Daaya...............................

Sai, You are ever engaged in rescuing those in distress,
Sai, Artha Thraana Paraayanaaya................................

Sa - i,  You are the Savior of the helpless ones,
Sa - i,  Anaatha Naathaaya..............................

42.  Om   Sri
42.  Om   Sri

43.  Om   Sri
43.  Om   Sri

Sai, You are fostering and guiding the interest of the whole world,
Sai, Lokarakshaa Paraayanaaya.......................................................

Sai, You are the Divine Master of Mankind,
Sai, Lokanathaaya........................................

You are the Embodiment
Anan-...............................

You are affectionately related to everyone in
Loka Baadha-..................................................

41. Om   Sri   Sai,
41. Om   Sri   Sai,

Sa - i, You......save those who surrender.....to God,
Sa - i, Sara......-......naagatha Thraa......-....naa-ya

Sa - i, You.......are the One who is always.........with us,
Sa - i,  Asa...........-.........haaya Sahaa........-........yaa-ya
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Na - ma - hah.......
Na - ma - hah.......

47. Om  Sri
47. Om  Sri

50. Om  Sri
50. Om  Sri

48. Om  Sri
48. Om  Sri

52. Om  Sri
52. Om  Sri

49. Om  Sri
49. Om  Sri

51. Om   Sri    Sai,
51. Om   Sri    Sai,

53. Om  Sri
53. Om  Sri

54. Om  Sri
54. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sa - i,  You nourish and sustain the afflicted ones,
Sa - i,  Deenajana Poshanaaya...............................

44. Om   Sri
44. Om   Sri

Na-ma-hah..
Na-ma-hah..

Sai,  You are Perfect and All Powerful,
Sai,  Kalusha Vidooraaya.....................

Sai, You are full of compassion and kindness,
Sai, Karunaakaraaya......................................

Sa - i,  You are the Sustainer and Supporter of all,
Sa - i,  Sarva Adhaaraaya........................................

Sai, You are the Savior from consequences of all immoral activities,
Sai, Sarva Paaya Kshaya Karaaya.....................................................

Sai, You are the Healer of all aliments and diseases,
Sai, Sarva Roga Nivaarine........................................

Sa - i,  You are the Destroyer of all sufferings,
Sa - i,  Sarva Baadha Haraaya........................

You are the Giver of Freedom and Liber-
Mukthi Pra-.............................................

46. Om  Sri  Sai,
46. Om  Sri  Sai,

You are the Giver of fruits of meritorious and be-ne-fi-
Punya Phala Pra-..........................................................

45. Om Sri

45. Om Sri

Sa - i, You...dwell in the region of the Heart...of all...beings,
Sa - i, Sar.........-..........va Hrud............-..............va..-...sine...

Sa-i, You....are the Divine Trinity: Brahma, Vishnu, Maheshwara;
                                                 responsible for creation, preservation
Sa-i, Moor.................-.........................thi Thraya Svaroo...................-

  and de-..struc-tion,
.................paa - ya..
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Na - ma - hah.......
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57. Om  Sri
57. Om  Sri

62. Om  Sri
62. Om  Sri

61. Om   Sri    Sai,
61. Om   Sri    Sai,

58. Om  Sri
58. Om  Sri

63. Om  Sri
63. Om  Sri

64. Om  Sri
64. Om  Sri

59. Om  Sri
59. Om  Sri

55. Om  Sri
55. Om  Sri

60. Om  Sri
60. Om  Sri

65. Om  Sri
65. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are the Infinite Power of the Divine Mother,
Sai, Aadi Shakthaye......................................................

Sai, You have delightful and wonderful powers,
Sai, Aparoopa Shakthine.....................................

Sa - i,  You are the Formless who has assumed human form,
Sa - i,  Avyaktha Roopine..........................................................

Sai, Your astonishing actions are not seen in anyone else,
Sai,  Adbhutha Charyaa........................................................

Sai, You are the Savior in times of calamity,
Sai, Aapad Baandhavaaya...........................

Sa - i,  You are Supreme Love,
Sa - i,  Premaatmane..............

56. Om  Sri  Sai,
56. Om  Sri  Sai,

You are the Very First Person, the One who was
Aadi Puru-..............................................................

You wear golden robes, the color
Kanakaambara Dhaa-................

Sa - i,  You....are the One Creator who is praised....eter-nally,
Sa - i,  A........-.........nantha Nutha Keer..........-.........tha-naaya

Sa - i, You....are the Destroyer of desire....and...anger,
Sa - i, Kama........-.........krodha...............Dhwam - sine

Sa - i,    You...are the Embodiment of....Divine Love,
Sa - i,    Pre.......-..........ma.......................Moor-thaye
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Na - ma - hah.......
Na - ma - hah.......

67. Om  Sri
67. Om  Sri

72. Om  Sri
72. Om  Sri

73. Om  Sri
73. Om  Sri

68. Om  Sri
68. Om  Sri

69. Om  Sri
69. Om  Sri

74. Om  Sri
74. Om  Sri

70. Om  Sri
70. Om  Sri

75. Om  Sri
75. Om  Sri

76. Om   Sri   Sai,
76. Om   Sri   Sai,

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are loved by all,
Sai, Priyaaya.................

Sai, You guide and guard the ones who surrender to God,
Sai, Bhaktha Priyaaya..........................................................

Sa - i,  You are the heavenly 'Wish-fulfilling Tree' for Your devotees,
Sa - i,  Bhaktha Mandaaraaya.............................................................

Sai, You illuminate the light of devotion and spiritual knowledge
Sai, Bhakthi Jnaana Pradeepaaya.................................................

66. Om  Sri  Sai,
66. Om  Sri  Sai,

Sai, You are bound by the devotion of Your followers,
Sai, Bhaktha Paraadheenaaya....................................

Sa - i,  You are the Grantor of devotion and wisdom,
Sa - i,  Bhakthi Jnaana Pradaaya.............................

You are the Inspirer and Granter of Love in all
Prema Pra-..........................................................

You dwell in the hearts of the de-
Bhaktha Jana Hridayala-...........

You are the Embodiment of Supreme
Jnaana Svaroo-.................................

Sa - i,    You....are playing in the hearts of....your bhakthas,.
Sa - i,    Bhaktha.......Jana Hridaya ..............Vi  -  haaraaya

Sa - i,    You...show the path of attaining...right knowledge,
Sa - i,    Su......-......jnaana Maarga............Darsa - kaaya.

71. Om   Sri   Sai,
71. Om   Sri   Sai,
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Na - ma - hah.......
Na - ma - hah.......

81. Om   Sri   Sai,
81. Om   Sri   Sai,

77. Om  Sri
77. Om  Sri

82. Om  Sri
82. Om  Sri

87. Om  Sri
87. Om  Sri

78. Om  Sri
78. Om  Sri

83. Om  Sri
83. Om  Sri

79. Om  Sri
79. Om  Sri

84. Om  Sri
84. Om  Sri

80. Om  Sri
80. Om  Sri

85. Om  Sri
85. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are the Giver and Teacher of the 'Gita',
Sai, Geethaa Bodhakaaya...................................

Sai,  You grant the urge for spiritual awareness,
Sai,  Jnana Siddhidaaya......................................

Sa -i,  You have a charming Divine Form,
Sa -i,  Sundararupaaya............................

Sai, You are supreme above all,
Sai, Purushothamaaya.............

Sai,  You are ever existent and permanent,
Sai,  Puraana Purushaaya.........................

Sa -i,  Your Glory pervades the Universe and transcends it,
Sa -i,  Atheethaaya...................................................................

Sai, Your power of will is immediately effective,
Sai, Siddha Sankalpaaya...................................

You bestow the fruits of all
Phala Pra-..........................

86. Om  Sri  Sai,
86. Om  Sri  Sai,

You are the Embodiment of Success, Prosperity and Per-
Siddhi Roo-........................................................................

Sa - i,   You....are the Embodiment of....Pu-rity,
Sa - i,  Pun......-........ya Puru. ......-.......shaa-ya

Sa - i, You.........are be..-..yond Time,
Sa - i, Kaa...-...laathee..-..taa..-..ya..
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Na - ma - hah.......
Na - ma - hah.......

91. Om   Sri   Sai,
91. Om   Sri   Sai,

92. Om  Sri
92. Om  Sri

97. Om  Sri
97. Om  Sri

88. Om  Sri
88. Om  Sri

93. Om  Sri
93. Om  Sri

98. Om  Sri
98. Om  Sri

89. Om  Sri
89. Om  Sri

94. Om  Sri
94. Om  Sri

90. Om  Sri
90. Om  Sri

95. Om  Sri
95. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai,  You bless us with good health and well being,
Sai,  Aarogya Pradaaya...........................................

Sa -i,  You are providing food, shelter and sustenance for all,
Sa -i,  Annavastradaaya.............................................................

Sai,  You are full of beneficial virtues,
Sai,  Kalyana Gunaaya......................

Sai,  You are the Destroyer of the Bondage of Karma,
Sai,  Karma Dhwamsine................................................

Sa -i,  You shine in the mind of good persons as brilliant knowledge,
Sa -i,  Saadhu Maanasa Sobhithaaya...................................................

Sai, You have planted the Banyan tree as a boon for spiritual
Sai, Saadhakaanugraha Vatavriksha Prathishthaapakaaya..

enlightenment,
.........................

Sai,  You are the Destroyer of All Doubts,
Sai,  Sakala Samsaya Haraaya................

96. Om   Sri   Sai,
96. Om   Sri   Sai,

You are the Giver of all Desirable
Sarvaabheeshta Pra-....................

You purify the mind of Your de-
Saadhu Maanasa Parishodha-

Sa - i,   You...destroy the cycle of birth and...death sufferings,
Sa - i,   Sam.....-........saara Duhkha..............Kshaya Karaaya

Sa - i,   You...accept and represent...all re-ligions,
Sa - i,   Sarva.....-......mata............Samma-thaaya
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101. Om   Sri   Sai,
101. Om   Sri   Sai,

102. Om  Sri
102. Om  Sri

103. Om  Sri
103. Om  Sri

99. Om  Sri
99. Om  Sri

104. Om  Sri
104. Om  Sri

100. Om  Sri
100. Om  Sri

105. Om  Sri
105. Om  Sri

106.
106.

107.
107.

108.
108.

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sa -i,  You are the Teacher of All Spiritual Wisdom,
Sa -i,  Sakalathathwa Bodhakaaya.........................

Sai, You are the Granter of Benevolence,
Sai, Sarva Mangalakaraaya...................

Sai,  You are the Bestower of All Accomplishments,
Sai,  Sarvasiddhi Pradaaya.....................................

Sa - i,  You are the Remover of Misfortunes,
Sa - i,  Aapannivarine...................................

You are revered by the masters of
Yogindra Vandi-..........................

Sa - i,   You...are the Lord of...all Yogis,
Sa - i,   Yo.....-.....giswa.....-.....raa - ya...

Sa - i,   You....destroy physical and....mental distress.
Sa - i,   Aar.......-........thiha..........-.........raa...-.....ya.....
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

3. Om  Sri
3. Om  Sri

7. Om  Sri
7. Om  Sri

5. Om  Sri
5. Om  Sri

2. Om  Sri
2. Om  Sri

4. Om  Sri
4. Om  Sri

Sa - i, You are the Giver of Boons which promote inner development,
Sa - i, Varadaaya.....................................................................................

Sai, Your Mission is the revival of Truth and Righteousness,
Sai, Sathya Dharma Paraayanaaya.......................................

Sai, You are the Embodiment of Truth,
Sai, Sathya Svaroopaaya......................

6.  Om  Sri  Sai,
6.  Om  Sri  Sai,

Sai, You promote righteousness, piety and perfection,
Sai, Sadhu Vardhanaaya................................................

You are our Divine Mother, Divine Father and Divine
Sathya Sai Baa-..............................................................

You are the Embodiment of all virtuous qua-
Sathya Gunaath............................................

Sa - i, You....are the Universal Eternal....Abso..-..lute,
Sa - i,  Sat...................... Puru-...................shaa..-..ya.

The English translation was authored by Rameesh & Ananda Kasturi of India in the booklet:
A BOUQUET OF108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHY SAI BABA.

The melody was transcribed as sung weekly by the Sai Center of South Miami, Florida, USA.
Harmonizations submitted by the transcriber. (13 April 1998)

1.  Om  Sri  Sai,
1.  Om  Sri  Sai,
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

13. Om  Sri
13. Om  Sri

12. Om  Sri
12. Om  Sri

11. Om  Sri  Sai,
11. Om  Sri  Sai,

Sai, You are the Supreme Manifestation of All Godheads,
Sai, Sarveshaaya..................................................................

Sai, You are the One without attachment,
Sai, Sarva Sanga Parithyaagine...............

Sa - i,  You are the Indweller in everyone's heart,
Sa - i,  Sarva Antharyaamine................................

14. Om  Sri
14. Om  Sri

You are the Motivator of all Universal En-
Sarva Shakthi Moor..................................

10. Om  Sri
10. Om  Sri

Sa - i, You.......are the Beloved of......every-one,
Sa - i, Sarva...........Jana Pri-............yaa..-..ya

9. Om  Sri
9. Om  Sri

Sa - i,  You are the One who knows everything,
Sa - i,  Sarvajnaaya..............................................

8. Om  Sri
8. Om  Sri

Sai, You are the Protector and Sustainer of all good people,
Sai, Sadhujana Poshanaaya....................................................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

21. Om Sri Sai,
21. Om Sri Sai,

You have taken human form in the religious kin-group of Sage
Bhaaradvaaja Rishi Go-.................................................................

Bhaarad-
.............

Na-ma-hah....
Na-ma-hah....

19. Om  Sri
19. Om  Sri

20. Om  Sri
20. Om  Sri

18. Om  Sri
18. Om  Sri

17. Om  Sri
17. Om  Sri

16. Om  Sri
16. Om  Sri

15. Om  Sri
15. Om  Sri

Sa - i, You.... assumed the form and name: "Jodi Adipalli..So-mappa",
Sa - i, Jodi..................................Aadipalli......................Somap-paaya

Sa - i,  Your glory and fame is the same as that of Shirdi Sai Baba,
Sa - i,  Yasahkaaya Shirdi Vaasine...................................................

Sai, You are Omnipresent while Your physical body resides in Holy
Sai, Parthi Kshethra Nivaasine............................................................

Parthi,
...........

Sai, You have manifested Yourself in the village Puttaparthi,
Sai, Parthi Gramodbhavaaya...................................................

Sai, You are the Supreme Lord Shiva, the Embodiment of Aus-pi-
Sai, Mahesvara Svaroo.......................................................................

Sa - i, You....are the Personification of....Glo-ry,
Sa - i, Ma.........-.............hima.......-.........atma-ne

A BOUQUET OF 108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA
(BHAGAVAN  SRI  SATHYA  SAI  BABA 

- Page 3
ASHTOTRA  SHATHANAAVALI)



F F Dm

C G Em

Em Dm7 G

Am Am Dm C/G G7 C CF/C

C C G7

rit-
traa-

uals,
ya

C

F F Dm

C G Em

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

26. Om  Sri   Sai,

26. Om  Sri   Sai,
...................................................traditional school of spiritual
Aapasthamba Su....................................................................

You chose to be born in the lineage of Sage Apasthamba's....

28. Om  Sri
28. Om  Sri

27. Om  Sri
27. Om  Sri

25. Om  Sri
25. Om  Sri

24. Om  Sri
24. Om  Sri

23. Om  Sri
23. Om  Sri

22. Om  Sri
22. Om  Sri

Sai, You have willed to take birth in the Ratnakara descendants,
Sai, Ratnaakara Vamshodhavaaya.................................................

Sai, You grant us the freedom from fear,
Sai, Abhaya Pradaaya..............................

Sa - i, You.............save us from.........all...fears,
Sa - i, Sarva...............Bhaya..........Nivaa-rine

Sa - i,  You are all Forms of God incarnated in one,
Sa - i, Avathaara Moortaye.......................................

Sai, You are the Innermost Self in every being,
Sai, Apaantharaathmane...................................

Sai, You are affectionate towards Your devotees like a mother,
Sai, Bhaktha Vathsalaaya............................................................

A BOUQUET OF 108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA
(BHAGAVAN  SRI  SATHYA  SAI  BABA 

- Page 4
ASHTOTRA  SHATHANAAVALI)



Em Dm7 G

Am Am Dm C/G G7 C CF/C

C C G7

Ba-
tha-

ba,
ye

C

F F Dm

C G Em

Em Dm7 G

Am Am Dm C/G G7 C CF/C

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

34. Om  Sri
34. Om  Sri

35. Om  Sri
35. Om  Sri

33. Om  Sri
33. Om  Sri

32. Om  Sri
32. Om  Sri

31. Om  Sri
31. Om  Sri

30. Om  Sri
30. Om  Sri

29. Om  Sri
29. Om  Sri

Sa - i, You......save those who surrender.....to God,
Sa - i, Sara......-......naagatha Thraa......-....naa-ya

Sa - i,  You bestow vigor, energy, intelligence & divine power on us,
Sa - i,  Shakthi Pradaaya......................................................................

Sai, You moved about on the banks of the Chitravathi River in Parthi,
Sai, Chithraavathee Thata Puttaparthi Vihaarine.................................

Sai, You are still The Resident of "Dwarakamayi",
Sai, Dwaarakaamaayi Vaasine.............................

Sai, You are the re-incarnation of Shirdi Sai
Sai, Shirdi Sai Moor........................................

Sa - i, You...confer happiness & prosperity upon...your devotees,
Sa - i, Sham.............-..............karaa...........-..............ya.................

Sa - i,  Your magnificence is identical to that of Shirdi Sai Baba,
Sa - i,  Shirdi Sai Abheda Shaktyaavathaaraaya.......................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

42.  Om   Sri
42.  Om   Sri

41.  Om   Sri
41.  Om   Sri

39.  Om   Sri
39.  Om   Sri

38.  Om   Sri
38.  Om   Sri

37.  Om   Sri
37.  Om   Sri

36.  Om   Sri
36.  Om   Sri

Sai, You are fostering and guiding the interest of the whole world,
Sai, Lokarakshaa Paraayanaaya.......................................................

Sai, You are affectionately related to everyone in
Sai, Loka Baadha-..................................................

Sa - i, You.......are the One who is always.........with us,
Sa - i,  Asa...........-.........haaya Sahaa........-........yaa-ya

40. Om   Sri
40  Om   Sri

Sa - i,  You are the Savior of the helpless ones,
Sa - i,  Anaatha Naathaaya..............................

Sai, You are ever engaged in rescuing those in distress,
Sai, Artha Thraana Paraayanaaya................................

Sai, You are the Granter of Eternal Joy,
Sai,  Aananda Daaya...............................

Sai, You are the Embodiment
Sai, Anan-...............................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

49. Om  Sri
49. Om  Sri

48. Om  Sri
48. Om  Sri

47. Om  Sri
47. Om  Sri

46. Om  Sri
46. Om  Sri

44. Om  Sri
44. Om  Sri

43. Om  Sri
43. Om  Sri

Sa - i,  You are the Sustainer and Supporter of all,
Sa - i,  Sarva Adhaaraaya........................................

Sai, You are full of compassion and kindness,
Sai, Karunaakaraaya......................................

Sai,  You are Perfect and All Powerful,
Sai,  Kalusha Vidooraaya.....................

Na-ma-hah..
Na-ma-hah..

Sai, You are the Giver of Freedom and Liber-
Sai, Mukthi Pra-.............................................

Sa-i, You....are the Divine Trinity: Brahma, Vishnu, Maheshwara;
                                                 responsible for creation, preservation
Sa-i, Moor.................-.........................thi Thraya Svaroo...................-

  and de-..struc-tion,
.................paa - ya..

45. Om  Sri

45. Om  Sri

Sa - i,  You nourish and sustain the afflicted ones,
Sa - i,  Deenajana Poshanaaya...............................

Sai, You are the Divine Master of Mankind,
Sai, Lokanathaaya........................................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

56. Om  Sri  Sai,
56. Om  Sri  Sai,

55. Om  Sri
55. Om  Sri

54. Om  Sri
54. Om  Sri

53. Om  Sri
53. Om  Sri

52. Om  Sri
52. Om  Sri

51. Om  Sri
51. Om  Sri

50. Om  Sri
50. Om  Sri

You are the Very First Person, the One who was
Aadi Puru-..............................................................

Sa - i,  You....are the One Creator who is praised....eter-nally,
Sa - i,  A........-.........nantha Nutha Keer..........-.........tha-naaya

Sa - i,  You are the Destroyer of all sufferings,
Sa - i,  Sarva Baadha Haraaya........................

Sai, You are the Healer of all aliments and diseases,
Sai, Sarva Roga Nivaarine........................................

Sai, You are the Savior from consequences of all immoral activities,
Sai, Sarva Paaya Kshaya Karaaya.....................................................

Sai, You are the Giver of fruits of meritorious and be-ne-fi-
Sai, Punya Phala Pra-..........................................................

Sa - i, You...dwell in the region of the Heart...of all...beings,
Sa - i, Sar.........-..........va Hrud............-..............va..-...sine...
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

63. Om  Sri
63. Om  Sri

62. Om  Sri
62. Om  Sri

60. Om  Sri
60. Om  Sri

59. Om  Sri
59. Om  Sri

58. Om  Sri
58. Om  Sri

57. Om  Sri
57. Om  Sri

Sai, You are the Savior in times of calamity,
Sai, Aapad Baandhavaaya...........................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, Your astonishing actions are not seen in anyone else,
Sai,  Adbhutha Charyaa........................................................

You wear golden robes, the color
Kanakaambara Dhaa-................

Sa - i, You....are the Destroyer of desire....and...anger,
Sa - i, Kama........-.........krodha...............Dhwam - sine

Sa - i,  You are the Formless who has assumed human form,
Sa - i,  Avyaktha Roopine..........................................................

Sai, You have delightful and wonderful powers,
Sai, Aparoopa Shakthine.....................................

Sai, You are the Infinite Power of the Divine Mother,
Sai, Aadi Shakthaye......................................................

61.  Om  Sri   Sai,
61.  Om  Sri   Sai,

A BOUQUET OF 108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA
(BHAGAVAN  SRI  SATHYA  SAI  BABA 

- Page 9
ASHTOTRA  SHATHANAAVALI)



Em Dm7 G

Am Am Dm C/G G7 C F/C C

C C G7

be-
daa-

ings,
ya

C

F F Dm

C G Em

Em Dm7 G

Am Am Dm C/G G7 C F/C C

70. Om  Sri
70. Om  Sri

64. Om  Sri
64. Om  Sri

65. Om  Sri
65. Om  Sri

66. Om  Sri
66. Om  Sri

67. Om  Sri
67. Om  Sri

68. Om  Sri
68. Om  Sri

69. Om  Sri
69. Om  Sri

Sa - i,    You....are playing in the hearts of....your bhakthas,.
Sa - i,    Bhaktha.......Jana Hridaya ..............Vi  -  haaraaya

Sa - i,  You are the heavenly 'Wish-fulfilling Tree' for Your devotees,
Sa - i,  Bhaktha Mandaaraaya.............................................................

Sai, You guide and guard the ones who surrender to God,
Sai, Bhaktha Priyaaya..........................................................

Sai, You are loved by all,
Sai, Priyaaya.................

Sa - i,    You...are the Embodiment of....Divine Love,
Sa - i,    Pre.......-..........ma.......................Moor-thaye

Sa - i,  You are Supreme Love,
Sa - i,  Premaatmane..............

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are the Inspirer and Granter of Love in all
Sai, Prema Pra-..........................................................
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71. Om  Sri
71. Om  Sri

72. Om  Sri
72. Om  Sri

73. Om  Sri
73. Om  Sri

74. Om  Sri
74. Om  Sri

75. Om  Sri
75. Om  Sri

76. Om  Sri
76. Om  Sri

77. Om  Sri
77. Om  Sri

Sai, You are the Giver and Teacher of the 'Gita',
Sai, Geethaa Bodhakaaya...................................

Sa - i,    You...show the path of attaining...right knowledge,
Sa - i,    Su......-......jnaana Maarga............Darsa - kaaya.

Sa - i,  You are the Grantor of devotion and wisdom,
Sa - i,  Bhakthi Jnaana Pradaaya.............................

Sai, You illuminate the light of devotion and spiritual knowledge
Sai, Bhakthi Jnaana Pradeepaaya.................................................

Sai, You are bound by the devotion of Your followers,
Sai, Bhaktha Paraadheenaaya....................................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You dwell in the hearts of the de-
Sai, Bhaktha Jana Hridayala-...........

Sai, You are the Embodiment of Supreme
Sai, Jnaana Svaroo-.................................

Na - ma - hah.......
Na - ma - hah.......
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78. Om  Sri
78. Om  Sri

79. Om  Sri
79. Om  Sri

80. Om  Sri
80. Om  Sri

81. Om  Sri
81. Om  Sri

82. Om  Sri
82. Om  Sri

83. Om  Sri
83. Om  Sri

84. Om  Sri
84. Om  Sri

Sa -i,  Your Glory pervades the Universe and transcends it,
Sa -i,  Atheethaaya...................................................................

Sai,  You are ever existent and permanent,
Sai,  Puraana Purushaaya.........................

Sai, You are supreme above all,
Sai, Purushothamaaya.............

Sa - i,   You....are the Embodiment of....Pu-rity,
Sa - i,  Pun......-........ya Puru. ......-.......shaa-ya

Sa -i,  You have a charming Divine Form,
Sa -i,  Sundararupaaya............................

Sai,  You grant the urge for spiritual awareness,
Sai,  Jnana Siddhidaaya......................................

Sai, You bestow the fruits of all
Sao, Phala Pra-..........................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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90. Om  Sri
90. Om  Sri

91. Om  Sri
91. Om  Sri

85. Om  Sri
85. Om  Sri

86. Om  Sri
86. Om  Sri

87. Om  Sri
87. Om  Sri

88. Om  Sri
88. Om  Sri

89. Om  Sri
89. Om  Sri

Sa - i,   You...destroy the cycle of birth and...death sufferings,
Sa - i,   Sam.....-........saara Duhkha..............Kshaya Karaaya

Sa -i,  You are providing food, shelter and sustenance for all,
Sa -i,  Annavastradaaya.............................................................

Sai,  You bless us with good health and well being,
Sai,  Aarogya Pradaaya...........................................

Sai, Your power of will is immediately effective,
Sai, Siddha Sankalpaaya...................................

Sa - i, You.........are be..-..yond Time,
Sa - i, Kaa...-...laathee..-..taa..-..ya..

Sai, You are the Embodiment of Success, Prosperity and Per-
Sai, Siddhi Roo-........................................................................

Sai, You are the Giver of all Desirable
Sai, Sarvaabheeshta Pra-....................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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92. Om  Sri
92. Om  Sri

93. Om  Sri
93. Om  Sri

94. Om  Sri
94. Om  Sri

95. Om  Sri
95. Om  Sri

96. Om  Sri
96. Om  Sri

97. Om  Sri
97. Om  Sri

98. Om  Sri
98. Om  Sri

Sai,  You are the Destroyer of All Doubts,
Sai,  Sakala Samsaya Haraaya................

Sai, You have planted the Banyan tree as a boon for spiritual
Sai, Saadhakaanugraha Vatavriksha Prathishthaapakaaya..

enlightenment,
.........................

Sa - i,   You...accept and represent...all re-ligions,
Sa - i,   Sarva.....-......mata............Samma-thaaya

Sa -i,  You shine in the mind of good persons as brilliant knowledge,
Sa -i,  Saadhu Maanasa Sobhithaaya...................................................

Sai,  You are the Destroyer of the Bondage of Karma,
Sai,  Karma Dhwamsine................................................

Sai,  You are full of beneficial virtues,
Sai,  Kalyana Gunaaya......................

Sai, You purify the mind of Your de-
Sai, Saadhu Maanasa Parishodha-

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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105. Om  Sri
105. Om  Sri

Sa - i,   You....destroy physical and....mental distress.
Sa - i,   Aar.......-........thiha..........-.........raa...-.....ya.....

104. Om  Sri
104. Om  Sri

103. Om  Sri
103. Om  Sri

102. Om  Sri
102. Om  Sri

101. Om  Sri
101. Om  Sri

100. Om  Sri
100. Om  Sri

99. Om  Sri
99. Om  Sri

Sa - i,  You are the Remover of Misfortunes,
Sa - i,  Aapannivarine...................................

Sai,  You are the Bestower of All Accomplishments,
Sai,  Sarvasiddhi Pradaaya.....................................

Sai, You are the Granter of Benevolence,
Sai, Sarva Mangalakaraaya...................

Sa - i,   You...are the Lord of...all Yogis,
Sa - i,   Yo.....-.....giswa.....-.....raa - ya...

Sa -i,  You are the Teacher of All Spiritual Wisdom,
Sa -i,  Sakalathathwa Bodhakaaya.........................

Sai, You are revered by the masters of
Sai, Yogindra Vandi-..........................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

3. Om  Sri
3. Om  Sri

7. Om  Sri
7. Om  Sri

8. Om  Sri
8. Om  Sri

5. Om  Sri
5. Om  Sri

10. Om  Sri
10. Om  Sri

2. Om  Sri
2. Om  Sri

4. Om  Sri
4. Om  Sri

Sa - i, You are the Giver of Boons which promote inner development,
Sa - i, Varadaaya.....................................................................................

Sai, Your Mission is the revival of Truth and Righteousness,
Sai, Sathya Dharma Paraayanaaya.......................................

Sai, You are the Embodiment of Truth,
Sai, Sathya Svaroopaaya......................

1.  Om  Sri  Sai,
1.  Om  Sri  Sai,

6.  Om  Sri  Sai,
6.  Om  Sri  Sai,

Sa - i,  You are the One who knows everything,
Sa - i,  Sarvajnaaya..............................................

Sai, You are the Protector and Sustainer of all good people,
Sai, Sadhujana Poshanaaya....................................................

Sai, You promote righteousness, piety and perfection,
Sai, Sadhu Vardhanaaya................................................

9. Om  Sri
9. Om  Sri

You are our Divine Mother, Divine Father and Divine
Sathya Sai Baa-..............................................................

You are the Embodiment of all virtuous qua-
Sathya Gunaath............................................

Sa - i, You....are the Universal Eternal....Abso..-..lute,
Sa - i,  Sat...................... Puru-...................shaa..-..ya.

Sa - i, You.......are the Beloved of......every-one,
Sa - i, Sarva...........Jana Pri-............yaa..-..ya

The English translation was authored by Rameesh & Ananda Kasturi of India in the booklet:
A BOUQUET OF108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHY SAI BABA.

The melody was transcribed as sung weekly by the Sai Center of South Miami, Florida, USA.
Harmonizations submitted by the transcriber. (13 April 1998)
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

19. Om  Sri
19. Om  Sri

15. Om  Sri
15. Om  Sri

20. Om  Sri
20. Om  Sri

21. Om Sri Sai,
21. Om Sri Sai,

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

13. Om  Sri
13. Om  Sri

18. Om  Sri
18. Om  Sri

16. Om Sri Sai,
16. Om Sri Sai,

12. Om  Sri
12. Om  Sri

17. Om  Sri
17. Om  Sri

11. Om  Sri  Sai,
11. Om  Sri  Sai,

Sai, You are the Supreme Manifestation of All Godheads,
Sai, Sarveshaaya..................................................................

Sai, You are the One without attachment,
Sai, Sarva Sanga Parithyaagine...............

Sa - i,  You are the Indweller in everyone's heart,
Sa - i,  Sarva Antharyaamine................................

14. Om  Sri
14. Om  Sri

Sai, You are Omnipresent while Your physical body resides in Holy
Sai, Parthi Kshethra Nivaasine............................................................

Parthi,
...........

Sa - i,  Your glory and fame is the same as that of Shirdi Sai Baba,
Sa - i,  Yasahkaaya Shirdi Vaasine...................................................

You are the Motivator of all Universal En-
Sarva Shakthi Moor..................................

You are the Supreme Lord Shiva, the Embodiment of Aus-pi-
Mahesvara Svaroo.......................................................................

Na-ma-hah....
Na-ma-hah....

Bhaarad-
.............

Sa - i, You....are the Personification of....Glo-ry,
Sa - i, Ma.........-.............hima.......-.........atma-ne

Sa - i, You.... assumed the form and name: "Jodi Adipalli..So-mappa",
Sa - i, Jodi..................................Aadipalli......................Somap-paaya

You have taken human form in the religious kin-group of Sage
Bhaaradvaaja Rishi Go-.................................................................

Sai,  You have manifested Yourself in the village Puttaparthi,
Sai,  Parthi Gramodbhavaaya...................................................
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Na - ma - hah.......
Na - ma - hah.......

24. Om  Sri
24. Om  Sri

23. Om  Sri
23. Om  Sri

22. Om  Sri
22. Om  Sri

25. Om  Sri
25. Om  Sri

27. Om  Sri
27. Om  Sri

32. Om  Sri
32. Om  Sri

30. Om  Sri
30. Om  Sri

28. Om  Sri
28. Om  Sri

29. Om  Sri
29. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are affectionate towards Your devotees like a mother,
Sai, Bhaktha Vathsalaaya............................................................

Sai, You are the Innermost Self in every being,
Sai, Apaantharaathmane...................................

Sa - i,  You are all Forms of God incarnated in one,
Sa - i, Avathaara Moortaye.......................................

Sai, You grant us the freedom from fear,
Sai, Abhaya Pradaaya..............................

Sai, You have willed to take birth in the Ratnakara descendants,
Sai, Ratnaakara Vamshodhavaaya.................................................

Sai, You are still The Resident of "Dwarakamayi",
Sai, Dwaarakaamaayi Vaasine.............................

...................................................traditional school of spiritual
Aapasthamba Su....................................................................

You chose to be born in the lineage of Sage Apasthamba's....

31. Om Sri  Sai,
31. Om Sri  Sai,

You are the re-incarnation of Shirdi Sai
Shirdi Sai Moor........................................

Sa - i, You.............save us from.........all...fears,
Sa - i, Sarva...............Bhaya..........Nivaa-rine

26. Om  Sri   Sai,

26. Om  Sri   Sai,

Sa - i, You...confer happiness & prosperity upon...your devotees,
Sa - i, Sham.............-..............karaa...........-..............ya.................

Sa - i,  Your magnificence is identical to that of Shirdi Sai Baba,
Sa - i,  Shirdi Sai Abheda Shaktyaavathaaraaya.......................
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Na - ma - hah.......
Na - ma - hah.......

36. Om   Sri    Sai,
36. Om   Sri    Sai,

37. Om  Sri
37. Om  Sri

35. Om  Sri
35. Om  Sri

40. Om  Sri
40. Om  Sri

33. Om  Sri
33. Om  Sri

38. Om  Sri
38. Om  Sri

39. Om  Sri
39. Om  Sri

34. Om  Sri
34. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You moved about on the banks of the Chitravathi River in Parthi,
Sai, Chithraavathee Thata Puttaparthi Vihaarine.................................

Sa - i,  You bestow vigor, energy, intelligence & divine power on us,
Sa - i,  Shakthi Pradaaya......................................................................

Sai, You are the Granter of Eternal Joy,
Sai,  Aananda Daaya...............................

Sai, You are ever engaged in rescuing those in distress,
Sai, Artha Thraana Paraayanaaya................................

Sa - i,  You are the Savior of the helpless ones,
Sa - i,  Anaatha Naathaaya..............................

42.  Om   Sri
42.  Om   Sri

43.  Om   Sri
43.  Om   Sri

Sai, You are fostering and guiding the interest of the whole world,
Sai, Lokarakshaa Paraayanaaya.......................................................

Sai, You are the Divine Master of Mankind,
Sai, Lokanathaaya........................................

You are the Embodiment
Anan-...............................

You are affectionately related to everyone in
Loka Baadha-..................................................

41. Om   Sri   Sai,
41. Om   Sri   Sai,

Sa - i, You......save those who surrender.....to God,
Sa - i, Sara......-......naagatha Thraa......-....naa-ya

Sa - i, You.......are the One who is always.........with us,
Sa - i,  Asa...........-.........haaya Sahaa........-........yaa-ya
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Na - ma - hah.......
Na - ma - hah.......

47. Om  Sri
47. Om  Sri

50. Om  Sri
50. Om  Sri

48. Om  Sri
48. Om  Sri

52. Om  Sri
52. Om  Sri

49. Om  Sri
49. Om  Sri

51. Om   Sri    Sai,
51. Om   Sri    Sai,

53. Om  Sri
53. Om  Sri

54. Om  Sri
54. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sa - i,  You nourish and sustain the afflicted ones,
Sa - i,  Deenajana Poshanaaya...............................

44. Om   Sri
44. Om   Sri

Na-ma-hah..
Na-ma-hah..

Sai,  You are Perfect and All Powerful,
Sai,  Kalusha Vidooraaya.....................

Sai, You are full of compassion and kindness,
Sai, Karunaakaraaya......................................

Sa - i,  You are the Sustainer and Supporter of all,
Sa - i,  Sarva Adhaaraaya........................................

Sai, You are the Savior from consequences of all immoral activities,
Sai, Sarva Paaya Kshaya Karaaya.....................................................

Sai, You are the Healer of all aliments and diseases,
Sai, Sarva Roga Nivaarine........................................

Sa - i,  You are the Destroyer of all sufferings,
Sa - i,  Sarva Baadha Haraaya........................

You are the Giver of Freedom and Liber-
Mukthi Pra-.............................................

46. Om  Sri  Sai,
46. Om  Sri  Sai,

You are the Giver of fruits of meritorious and be-ne-fi-
Punya Phala Pra-..........................................................

45. Om Sri

45. Om Sri

Sa - i, You...dwell in the region of the Heart...of all...beings,
Sa - i, Sar.........-..........va Hrud............-..............va..-...sine...

  and de-..struc-tion,
...................paa - ya..

Sa-i, You....are the Divine Trinity: Brahma, Vishnu, Maheshwara;
                                        responsible for creation, preservation
Sa-i, Moor...............-.....................thi Thraya Svaroo................-

A BOUQUET OF 108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA
(BHAGAVAN  SRI  SATHYA  SAI  BABA ASHTOTRA  SHATHANAAVALI)

- Page 5



Cm Cm Fm E /B B 7 E A /C E

E E B 7

and
shaa-

is,
ya

E

A A Fm

E B Gm

Gm Fm7 B

Cm Cm Fm E /B B 7 E A /C E

E E B 7

of
ri -

God,
ne

E

A A Fm

E B Gm

Gm Fm7 B

Cm Cm Fm E /B B 7 E A /C E

Na - ma - hah.......
Na - ma - hah.......

57. Om  Sri
57. Om  Sri

62. Om  Sri
62. Om  Sri

61. Om   Sri    Sai,
61. Om   Sri    Sai,

58. Om  Sri
58. Om  Sri

63. Om  Sri
63. Om  Sri

64. Om  Sri
64. Om  Sri

59. Om  Sri
59. Om  Sri

55. Om  Sri
55. Om  Sri

60. Om  Sri
60. Om  Sri

65. Om  Sri
65. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are the Infinite Power of the Divine Mother,
Sai, Aadi Shakthaye......................................................

Sai, You have delightful and wonderful powers,
Sai, Aparoopa Shakthine.....................................

Sa - i,  You are the Formless who has assumed human form,
Sa - i,  Avyaktha Roopine..........................................................

Sai, Your astonishing actions are not seen in anyone else,
Sai,  Adbhutha Charyaa........................................................

Sai, You are the Savior in times of calamity,
Sai, Aapad Baandhavaaya...........................

Sa - i,  You are Supreme Love,
Sa - i,  Premaatmane..............

56. Om  Sri  Sai,
56. Om  Sri  Sai,

You are the Very First Person, the One who was
Aadi Puru-..............................................................

You wear golden robes, the color
Kanakaambara Dhaa-................

Sa - i,  You....are the One Creator who is praised....eter-nally,
Sa - i,  A........-.........nantha Nutha Keer..........-.........tha-naaya

Sa - i, You....are the Destroyer of desire....and...anger,
Sa - i, Kama........-.........krodha...............Dhwam - sine

Sa - i,    You...are the Embodiment of....Divine Love,
Sa - i,    Pre.......-..........ma.......................Moor-thaye
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Na - ma - hah.......
Na - ma - hah.......

67. Om  Sri
67. Om  Sri

72. Om  Sri
72. Om  Sri

73. Om  Sri
73. Om  Sri

68. Om  Sri
68. Om  Sri

69. Om  Sri
69. Om  Sri

74. Om  Sri
74. Om  Sri

70. Om  Sri
70. Om  Sri

75. Om  Sri
75. Om  Sri

76. Om   Sri   Sai,
76. Om   Sri   Sai,

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are loved by all,
Sai, Priyaaya.................

Sai, You guide and guard the ones who surrender to God,
Sai, Bhaktha Priyaaya..........................................................

Sa - i,  You are the heavenly 'Wish-fulfilling Tree' for Your devotees,
Sa - i,  Bhaktha Mandaaraaya.............................................................

Sai, You illuminate the light of devotion and spiritual knowledge
Sai, Bhakthi Jnaana Pradeepaaya.................................................

66. Om  Sri  Sai,
66. Om  Sri  Sai,

Sai, You are bound by the devotion of Your followers,
Sai, Bhaktha Paraadheenaaya....................................

Sa - i,  You are the Grantor of devotion and wisdom,
Sa - i,  Bhakthi Jnaana Pradaaya.............................

You are the Inspirer and Granter of Love in all
Prema Pra-..........................................................

You dwell in the hearts of the de-
Bhaktha Jana Hridayala-...........

You are the Embodiment of Supreme
Jnaana Svaroo-.................................

Sa - i,    You....are playing in the hearts of....your bhakthas,.
Sa - i,    Bhaktha.......Jana Hridaya ..............Vi  -  haaraaya

Sa - i,    You...show the path of attaining...right knowledge,
Sa - i,    Su......-......jnaana Maarga............Darsa - kaaya.

71. Om   Sri   Sai,
71. Om   Sri   Sai,
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Na - ma - hah.......
Na - ma - hah.......

81. Om   Sri   Sai,
81. Om   Sri   Sai,

77. Om  Sri
77. Om  Sri

82. Om  Sri
82. Om  Sri

87. Om  Sri
87. Om  Sri

78. Om  Sri
78. Om  Sri

83. Om  Sri
83. Om  Sri

79. Om  Sri
79. Om  Sri

84. Om  Sri
84. Om  Sri

80. Om  Sri
80. Om  Sri

85. Om  Sri
85. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are the Giver and Teacher of the 'Gita',
Sai, Geethaa Bodhakaaya...................................

Sai,  You grant the urge for spiritual awareness,
Sai,  Jnana Siddhidaaya......................................

Sa -i,  You have a charming Divine Form,
Sa -i,  Sundararupaaya............................

Sai, You are supreme above all,
Sai, Purushothamaaya.............

Sai,  You are ever existent and permanent,
Sai,  Puraana Purushaaya.........................

Sa -i,  Your Glory pervades the Universe and transcends it,
Sa -i,  Atheethaaya...................................................................

Sai, Your power of will is immediately effective,
Sai, Siddha Sankalpaaya...................................

You bestow the fruits of all
Phala Pra-..........................

86. Om  Sri  Sai,
86. Om  Sri  Sai,

You are the Embodiment of Success, Prosperity and Per-
Siddhi Roo-........................................................................

Sa - i,   You....are the Embodiment of....Pu-rity,
Sa - i,  Pun......-........ya Puru. ......-.......shaa-ya

Sa - i, You.........are be..-..yond Time,
Sa - i, Kaa...-...laathee..-..taa..-..ya..
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91. Om   Sri   Sai,
91. Om   Sri   Sai,

92. Om  Sri
92. Om  Sri

97. Om  Sri
97. Om  Sri

88. Om  Sri
88. Om  Sri

93. Om  Sri
93. Om  Sri

98. Om  Sri
98. Om  Sri

89. Om  Sri
89. Om  Sri

94. Om  Sri
94. Om  Sri

90. Om  Sri
90. Om  Sri

95. Om  Sri
95. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai,  You bless us with good health and well being,
Sai,  Aarogya Pradaaya...........................................

Sa -i,  You are providing food, shelter and sustenance for all,
Sa -i,  Annavastradaaya.............................................................

Sai,  You are full of beneficial virtues,
Sai,  Kalyana Gunaaya......................

Sai,  You are the Destroyer of the Bondage of Karma,
Sai,  Karma Dhwamsine................................................

Sa -i,  You shine in the mind of good persons as brilliant knowledge,
Sa -i,  Saadhu Maanasa Sobhithaaya...................................................

Sai, You have planted the Banyan tree as a boon for spiritual
Sai, Saadhakaanugraha Vatavriksha Prathishthaapakaaya..

enlightenment,
.........................

Sai,  You are the Destroyer of All Doubts,
Sai,  Sakala Samsaya Haraaya................

96. Om   Sri   Sai,
96. Om   Sri   Sai,

You are the Giver of all Desirable
Sarvaabheeshta Pra-....................

You purify the mind of Your de-
Saadhu Maanasa Parishodha-

Sa - i,   You...destroy the cycle of birth and...death sufferings,
Sa - i,   Sam.....-........saara Duhkha..............Kshaya Karaaya

Sa - i,   You...accept and represent...all re-ligions,
Sa - i,   Sarva.....-......mata............Samma-thaaya

Na - ma -hah..
Na - ma -hah..
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101. Om   Sri   Sai,
101. Om   Sri   Sai,

102. Om  Sri
102. Om  Sri

103. Om  Sri
103. Om  Sri

99. Om  Sri
99. Om  Sri

104. Om  Sri
104. Om  Sri

100. Om  Sri
100. Om  Sri

105. Om  Sri
105. Om  Sri

106.
106.

107.
107.

108.
108.

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sa -i,  You are the Teacher of All Spiritual Wisdom,
Sa -i,  Sakalathathwa Bodhakaaya.........................

Sai, You are the Granter of Benevolence,
Sai, Sarva Mangalakaraaya...................

Sai,  You are the Bestower of All Accomplishments,
Sai,  Sarvasiddhi Pradaaya.....................................

Sa - i,  You are the Remover of Misfortunes,
Sa - i,  Aapannivarine...................................

You are revered by the masters of
Yogindra Vandi-..........................

Sa - i,   You...are the Lord of...all Yogis,
Sa - i,   Yo.....-.....giswa.....-.....raa - ya...

Sa - i,   You....destroy physical and....mental distress.
Sa - i,   Aar.......-........thiha..........-.........raa...-.....ya.....
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

3. Om  Sri
3. Om  Sri

7. Om  Sri
7. Om  Sri

5. Om  Sri
5. Om  Sri

2. Om  Sri
2. Om  Sri

4. Om  Sri
4. Om  Sri

Sa - i, You are the Giver of Boons which promote inner development,
Sa - i, Varadaaya.....................................................................................

Sai, Your Mission is the revival of Truth and Righteousness,
Sai, Sathya Dharma Paraayanaaya.......................................

Sai, You are the Embodiment of Truth,
Sai, Sathya Svaroopaaya......................

6.  Om  Sri  Sai,
6.  Om  Sri  Sai,

Sai, You promote righteousness, piety and perfection,
Sai, Sadhu Vardhanaaya................................................

You are our Divine Mother, Divine Father and Divine
Sathya Sai Baa-..............................................................

You are the Embodiment of all virtuous qua-
Sathya Gunaath............................................

Sa - i, You....are the Universal Eternal....Abso..-..lute,
Sa - i,  Sat...................... Puru-...................shaa..-..ya.

The English translation was authored by Rameesh & Ananda Kasturi of India in the booklet:
A BOUQUET OF108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHY SAI BABA.

The melody was transcribed as sung weekly by the Sai Center of South Miami, Florida, USA.
Harmonizations submitted by the transcriber. (13 April 1998)

1.  Om  Sri  Sai,
1.  Om  Sri  Sai,

Key of E-flat
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

13. Om  Sri
13. Om  Sri

12. Om  Sri
12. Om  Sri

11. Om  Sri  Sai,
11. Om  Sri  Sai,

Sai, You are the Supreme Manifestation of All Godheads,
Sai, Sarveshaaya..................................................................

Sai, You are the One without attachment,
Sai, Sarva Sanga Parithyaagine...............

Sa - i,  You are the Indweller in everyone's heart,
Sa - i,  Sarva Antharyaamine................................

14. Om  Sri
14. Om  Sri

You are the Motivator of all Universal En-
Sarva Shakthi Moor..................................

10. Om  Sri
10. Om  Sri

Sa - i, You.......are the Beloved of......every-one,
Sa - i, Sarva...........Jana Pri-............yaa..-..ya

9. Om  Sri
9. Om  Sri

Sa - i,  You are the One who knows everything,
Sa - i,  Sarvajnaaya..............................................

8. Om  Sri
8. Om  Sri

Sai, You are the Protector and Sustainer of all good people,
Sai, Sadhujana Poshanaaya....................................................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

21. Om Sri Sai,
21. Om Sri Sai,

You have taken human form in the religious kin-group of Sage
Bhaaradvaaja Rishi Go-.................................................................

Bhaarad-
.............

Na-ma-hah....
Na-ma-hah....

19. Om  Sri
19. Om  Sri

20. Om  Sri
20. Om  Sri

18. Om  Sri
18. Om  Sri

17. Om  Sri
17. Om  Sri

16. Om  Sri
16. Om  Sri

15. Om  Sri
15. Om  Sri

Sa - i, You.... assumed the form and name: "Jodi Adipalli..So-mappa",
Sa - i, Jodi..................................Aadipalli......................Somap-paaya

Sa - i,  Your glory and fame is the same as that of Shirdi Sai Baba,
Sa - i,  Yasahkaaya Shirdi Vaasine...................................................

Sai, You are Omnipresent while Your physical body resides in Holy
Sai, Parthi Kshethra Nivaasine............................................................

Parthi,
...........

Sai, You have manifested Yourself in the village Puttaparthi,
Sai, Parthi Gramodbhavaaya...................................................

Sai, You are the Supreme Lord Shiva, the Embodiment of Aus-pi-
Sai, Mahesvara Svaroo.......................................................................

Sa - i, You....are the Personification of....Glo-ry,
Sa - i, Ma.........-.............hima.......-.........atma-ne
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

26. Om  Sri   Sai,

26. Om  Sri   Sai,
...................................................traditional school of spiritual
Aapasthamba Su....................................................................

You chose to be born in the lineage of Sage Apasthamba's....

28. Om  Sri
28. Om  Sri

27. Om  Sri
27. Om  Sri

25. Om  Sri
25. Om  Sri

24. Om  Sri
24. Om  Sri

23. Om  Sri
23. Om  Sri

22. Om  Sri
22. Om  Sri

Sai, You have willed to take birth in the Ratnakara descendants,
Sai, Ratnaakara Vamshodhavaaya.................................................

Sai, You grant us the freedom from fear,
Sai, Abhaya Pradaaya..............................

Sa - i, You.............save us from.........all...fears,
Sa - i, Sarva...............Bhaya..........Nivaa-rine

Sa - i,  You are all Forms of God incarnated in one,
Sa - i, Avathaara Moortaye.......................................

Sai, You are the Innermost Self in every being,
Sai, Apaantharaathmane...................................

Sai, You are affectionate towards Your devotees like a mother,
Sai, Bhaktha Vathsalaaya............................................................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

34. Om  Sri
34. Om  Sri

35. Om  Sri
35. Om  Sri

33. Om  Sri
33. Om  Sri

32. Om  Sri
32. Om  Sri

31. Om  Sri
31. Om  Sri

30. Om  Sri
30. Om  Sri

29. Om  Sri
29. Om  Sri

Sa - i, You......save those who surrender.....to God,
Sa - i, Sara......-......naagatha Thraa......-....naa-ya

Sa - i,  You bestow vigor, energy, intelligence & divine power on us,
Sa - i,  Shakthi Pradaaya......................................................................

Sai, You moved about on the banks of the Chitravathi River in Parthi,
Sai, Chithraavathee Thata Puttaparthi Vihaarine.................................

Sai, You are still The Resident of "Dwarakamayi",
Sai, Dwaarakaamaayi Vaasine.............................

Sai, You are the re-incarnation of Shirdi Sai
Sai, Shirdi Sai Moor........................................

Sa - i, You...confer happiness & prosperity upon...your devotees,
Sa - i, Sham.............-..............karaa...........-..............ya.................

Sa - i,  Your magnificence is identical to that of Shirdi Sai Baba,
Sa - i,  Shirdi Sai Abheda Shaktyaavathaaraaya.......................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

42.  Om   Sri
42.  Om   Sri

41.  Om   Sri
41.  Om   Sri

39.  Om   Sri
39.  Om   Sri

38.  Om   Sri
38.  Om   Sri

37.  Om   Sri
37.  Om   Sri

36.  Om   Sri
36.  Om   Sri

Sai, You are fostering and guiding the interest of the whole world,
Sai, Lokarakshaa Paraayanaaya.......................................................

Sai, You are affectionately related to everyone in
Sai, Loka Baadha-..................................................

Sa - i, You.......are the One who is always.........with us,
Sa - i,  Asa...........-.........haaya Sahaa........-........yaa-ya

40. Om   Sri
40  Om   Sri

Sa - i,  You are the Savior of the helpless ones,
Sa - i,  Anaatha Naathaaya..............................

Sai, You are ever engaged in rescuing those in distress,
Sai, Artha Thraana Paraayanaaya................................

Sai, You are the Granter of Eternal Joy,
Sai,  Aananda Daaya...............................

Sai, You are the Embodiment
Sai, Anan-...............................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

49. Om  Sri
49. Om  Sri

48. Om  Sri
48. Om  Sri

47. Om  Sri
47. Om  Sri

46. Om  Sri
46. Om  Sri

44. Om  Sri
44. Om  Sri

43. Om  Sri
43. Om  Sri

Sa - i,  You are the Sustainer and Supporter of all,
Sa - i,  Sarva Adhaaraaya........................................

Sai, You are full of compassion and kindness,
Sai, Karunaakaraaya......................................

Sai,  You are Perfect and All Powerful,
Sai,  Kalusha Vidooraaya.....................

Na-ma-hah..
Na-ma-hah..

Sai, You are the Giver of Freedom and Liber-
Sai, Mukthi Pra-.............................................

  and de-..struc-tion,
.................paa - ya..

45. Om  Sri

45. Om  Sri

Sa - i,  You nourish and sustain the afflicted ones,
Sa - i,  Deenajana Poshanaaya...............................

Sai, You are the Divine Master of Mankind,
Sai, Lokanathaaya........................................

Sa-i, You....are the Divine Trinity: Brahma, Vishnu, Maheshwara;
                                           responsible for creation, preservation
Sa-i, Moor.................-.........................thi Thraya Svaroo..............-
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

56. Om  Sri  Sai,
56. Om  Sri  Sai,

55. Om  Sri
55. Om  Sri

54. Om  Sri
54. Om  Sri

53. Om  Sri
53. Om  Sri

52. Om  Sri
52. Om  Sri

51. Om  Sri
51. Om  Sri

50. Om  Sri
50. Om  Sri

You are the Very First Person, the One who was
Aadi Puru-..............................................................

Sa - i,  You....are the One Creator who is praised....eter-nally,
Sa - i,  A........-.........nantha Nutha Keer..........-.........tha-naaya

Sa - i,  You are the Destroyer of all sufferings,
Sa - i,  Sarva Baadha Haraaya........................

Sai, You are the Healer of all aliments and diseases,
Sai, Sarva Roga Nivaarine........................................

Sai, You are the Savior from consequences of all immoral activities,
Sai, Sarva Paaya Kshaya Karaaya.....................................................

Sai, You are the Giver of fruits of meritorious and be-ne-fi-
Sai, Punya Phala Pra-..........................................................

Sa - i, You...dwell in the region of the Heart...of all...beings,
Sa - i, Sar.........-..........va Hrud............-..............va..-...sine...
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

63. Om  Sri
63. Om  Sri

62. Om  Sri
62. Om  Sri

60. Om  Sri
60. Om  Sri

59. Om  Sri
59. Om  Sri

58. Om  Sri
58. Om  Sri

57. Om  Sri
57. Om  Sri

Sai, You are the Savior in times of calamity,
Sai, Aapad Baandhavaaya...........................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, Your astonishing actions are not seen in anyone else,
Sai,  Adbhutha Charyaa........................................................

You wear golden robes, the color
Kanakaambara Dhaa-................

Sa - i, You....are the Destroyer of desire....and...anger,
Sa - i, Kama........-.........krodha...............Dhwam - sine

Sa - i,  You are the Formless who has assumed human form,
Sa - i,  Avyaktha Roopine..........................................................

Sai, You have delightful and wonderful powers,
Sai, Aparoopa Shakthine.....................................

Sai, You are the Infinite Power of the Divine Mother,
Sai, Aadi Shakthaye......................................................

61.  Om  Sri   Sai,
61.  Om  Sri   Sai,
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70. Om  Sri
70. Om  Sri

64. Om  Sri
64. Om  Sri

65. Om  Sri
65. Om  Sri

66. Om  Sri
66. Om  Sri

67. Om  Sri
67. Om  Sri

68. Om  Sri
68. Om  Sri

69. Om  Sri
69. Om  Sri

Sa - i,    You....are playing in the hearts of....your bhakthas,.
Sa - i,    Bhaktha.......Jana Hridaya ..............Vi  -  haaraaya

Sa - i,  You are the heavenly 'Wish-fulfilling Tree' for Your devotees,
Sa - i,  Bhaktha Mandaaraaya.............................................................

Sai, You guide and guard the ones who surrender to God,
Sai, Bhaktha Priyaaya..........................................................

Sai, You are loved by all,
Sai, Priyaaya.................

Sa - i,    You...are the Embodiment of....Divine Love,
Sa - i,    Pre.......-..........ma.......................Moor-thaye

Sa - i,  You are Supreme Love,
Sa - i,  Premaatmane..............

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are the Inspirer and Granter of Love in all
Sai, Prema Pra-..........................................................
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71. Om  Sri
71. Om  Sri

72. Om  Sri
72. Om  Sri

73. Om  Sri
73. Om  Sri

74. Om  Sri
74. Om  Sri

75. Om  Sri
75. Om  Sri

76. Om  Sri
76. Om  Sri

77. Om  Sri
77. Om  Sri

Sai, You are the Giver and Teacher of the 'Gita',
Sai, Geethaa Bodhakaaya...................................

Sa - i,    You...show the path of attaining...right knowledge,
Sa - i,    Su......-......jnaana Maarga............Darsa - kaaya.

Sa - i,  You are the Grantor of devotion and wisdom,
Sa - i,  Bhakthi Jnaana Pradaaya.............................

Sai, You illuminate the light of devotion and spiritual knowledge
Sai, Bhakthi Jnaana Pradeepaaya.................................................

Sai, You are bound by the devotion of Your followers,
Sai, Bhaktha Paraadheenaaya....................................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You dwell in the hearts of the de-
Sai, Bhaktha Jana Hridayala-...........

Sai, You are the Embodiment of Supreme
Sai, Jnaana Svaroo-.................................

Na - ma - hah.......
Na - ma - hah.......
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78. Om  Sri
78. Om  Sri

79. Om  Sri
79. Om  Sri

80. Om  Sri
80. Om  Sri

81. Om  Sri
81. Om  Sri

82. Om  Sri
82. Om  Sri

83. Om  Sri
83. Om  Sri

84. Om  Sri
84. Om  Sri

Sa -i,  Your Glory pervades the Universe and transcends it,
Sa -i,  Atheethaaya...................................................................

Sai,  You are ever existent and permanent,
Sai,  Puraana Purushaaya.........................

Sai, You are supreme above all,
Sai, Purushothamaaya.............

Sa - i,   You....are the Embodiment of....Pu-rity,
Sa - i,  Pun......-........ya Puru. ......-.......shaa-ya

Sa -i,  You have a charming Divine Form,
Sa -i,  Sundararupaaya............................

Sai,  You grant the urge for spiritual awareness,
Sai,  Jnana Siddhidaaya......................................

Sai, You bestow the fruits of all
Sao, Phala Pra-..........................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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90. Om  Sri
90. Om  Sri

91. Om  Sri
91. Om  Sri

85. Om  Sri
85. Om  Sri

86. Om  Sri
86. Om  Sri

87. Om  Sri
87. Om  Sri

88. Om  Sri
88. Om  Sri

89. Om  Sri
89. Om  Sri

Sa - i,   You...destroy the cycle of birth and...death sufferings,
Sa - i,   Sam.....-........saara Duhkha..............Kshaya Karaaya

Sa -i,  You are providing food, shelter and sustenance for all,
Sa -i,  Annavastradaaya.............................................................

Sai,  You bless us with good health and well being,
Sai,  Aarogya Pradaaya...........................................

Sai, Your power of will is immediately effective,
Sai, Siddha Sankalpaaya...................................

Sa - i, You.........are be..-..yond Time,
Sa - i, Kaa...-...laathee..-..taa..-..ya..

Sai, You are the Embodiment of Success, Prosperity and Per-
Sai, Siddhi Roo-........................................................................

Sai, You are the Giver of all Desirable
Sai, Sarvaabheeshta Pra-....................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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92. Om  Sri
92. Om  Sri

93. Om  Sri
93. Om  Sri

94. Om  Sri
94. Om  Sri

95. Om  Sri
95. Om  Sri

96. Om  Sri
96. Om  Sri

97. Om  Sri
97. Om  Sri

98. Om  Sri
98. Om  Sri

Sai,  You are the Destroyer of All Doubts,
Sai,  Sakala Samsaya Haraaya................

Sai, You have planted the Banyan tree as a boon for spiritual
Sai, Saadhakaanugraha Vatavriksha Prathishthaapakaaya..

enlightenment,
.........................

Sa - i,   You...accept and represent...all re-ligions,
Sa - i,   Sarva.....-......mata............Samma-thaaya

Sa -i,  You shine in the mind of good persons as brilliant knowledge,
Sa -i,  Saadhu Maanasa Sobhithaaya...................................................

Sai,  You are the Destroyer of the Bondage of Karma,
Sai,  Karma Dhwamsine................................................

Sai,  You are full of beneficial virtues,
Sai,  Kalyana Gunaaya......................

Sai, You purify the mind of Your de-
Sai, Saadhu Maanasa Parishodha-

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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105. Om  Sri
105. Om  Sri

Sa - i,   You....destroy physical and....mental distress.
Sa - i,   Aar.......-........thiha..........-.........raa...-.....ya.....

104. Om  Sri
104. Om  Sri

103. Om  Sri
103. Om  Sri

102. Om  Sri
102. Om  Sri

101. Om  Sri
101. Om  Sri

100. Om  Sri
100. Om  Sri

99. Om  Sri
99. Om  Sri

Sa - i,  You are the Remover of Misfortunes,
Sa - i,  Aapannivarine...................................

Sai,  You are the Bestower of All Accomplishments,
Sai,  Sarvasiddhi Pradaaya.....................................

Sai, You are the Granter of Benevolence,
Sai, Sarva Mangalakaraaya...................

Sa - i,   You...are the Lord of...all Yogis,
Sa - i,   Yo.....-.....giswa.....-.....raa - ya...

Sa -i,  You are the Teacher of All Spiritual Wisdom,
Sa -i,  Sakalathathwa Bodhakaaya.........................

Sai, You are revered by the masters of
Sai, Yogindra Vandi-..........................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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